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Preface

This preface contains the following sections:

 • Audience and Use, page vii

 • Documentation Conventions, page viii

 • Cisco Unity Documentation, page viii

 • Obtaining Documentation, page viii

 • Documentation Feedback, page x

 • Cisco Product Security Overview, page x

 • Obtaining Technical Assistance, page xi

 • Obtaining Additional Publications and Information, page xii

Audience and Use
The Cisco Unity Documentation Addendum, Release 4.1 is designed to be used in conjunction with the 
4.0(5) and later versions of Cisco Unity guides on Cisco.com at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/tsd_products_support_series_home.html. 
Everything in those guides applies to version 4.1, except as noted in this addendum.

Each chapter in the addendum corresponds to a guide in the product documentation set. New features 
are described in topics in the applicable guide chapter. Information that has changed in a guide—either 
because Cisco Unity functionality changed or because the information is incorrect—is described in the 
“Errors” section at the end of the guide chapter in the addendum.

Note that if a guide has no corresponding chapter in the addendum, it means that there is no new or 
changed content, and the 4.0(5) and later version of the guide on Cisco.com applies to 4.1.
vii
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Preface
Documentation Conventions
Documentation Conventions

The Cisco Unity 4.1 Documentation Addendum also uses the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in 
the document.

Caution Means reader be careful. In this situation, you might do something that could result in equipment 
damage or loss of data.

 

Cisco Unity Documentation
For descriptions and URLs of Cisco Unity documentation on Cisco.com, refer to the Cisco Unity 
Documentation Guide. The document is shipped with Cisco Unity and is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/about/aboutdoc.htm.

 

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Table 1 Cisco Unity 4.1 Documentation Addendum Conventions 

Convention Description

boldfaced text Boldfaced text is used for:

 • Key and button names. (Example: Click OK.)

 • Information that you enter. (Example: Enter Administrator in the User 
Name box.)

< > 

(angle brackets)

Angle brackets are used around parameters for which you supply a value. 
(Example: In the Command Prompt window, enter ping <IP address>.)

- 

(hyphen)

Hyphens separate keys that must be pressed simultaneously. (Example: Press 
Ctrl-Alt-Delete.)

> 

(right angle  
bracket)

A right angle bracket is used to separate selections that you make:

 • On menus. (Example: On the Windows Start menu, click Settings > Control 
Panel > Phone and Modem Options.)

 • In the navigation bar of the Cisco Unity Administrator. (Example: Go to the 
System > Configuration > Settings page.)
viii
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Preface
Obtaining Documentation
Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
Cisco documentation and additional literature are available in the Product Documentation DVD package, 
which may have shipped with your product. The Product Documentation DVD is updated regularly and 
may be more current than printed documentation.

The Product Documentation DVD is a comprehensive library of technical product documentation on 
portable media. The DVD enables you to access multiple versions of hardware and software installation, 
configuration, and command guides for Cisco products and to view technical documentation in HTML. 
With the DVD, you have access to the same documentation that is found on the Cisco website without 
being connected to the Internet. Certain products also have .pdf versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. Registered Cisco.com 
users (Cisco direct customers) can order a Product Documentation DVD (product number 
DOC-DOCDVD=) from the Ordering tool or Cisco Marketplace.

Cisco Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

Cisco Marketplace:

http://www.cisco.com/go/marketplace/

Ordering Documentation
Beginning June 30, 2005, registered Cisco.com users may order Cisco documentation at the Product 
Documentation Store in the Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Cisco will continue to support documentation orders using the Ordering tool:

 • Registered Cisco.com users (Cisco direct customers) can order documentation from the 
Ordering tool:

http://www.cisco.com/en/US/partner/ordering/

 • Instructions for ordering documentation using the Ordering tool are at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

 • Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 1 800 553-NETS (6387).
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Preface
Documentation Feedback
Documentation Feedback
You can rate and provide feedback about Cisco technical documents by completing the online feedback 
form that appears with the technical documents on Cisco.com.

You can send comments about Cisco documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems 
Attn: Customer Document Ordering 
170 West Tasman Drive 
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you can perform these tasks:

 • Report security vulnerabilities in Cisco products.

 • Obtain assistance with security incidents that involve Cisco products.

 • Register to receive security information from Cisco.

A current list of security advisories and notices for Cisco products is available at this URL:

http://www.cisco.com/go/psirt

If you prefer to see advisories and notices as they are updated in real time, you can access a Product 
Security Incident Response Team Really Simple Syndication (PSIRT RSS) feed from this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release them, 
and we strive to correct all vulnerabilities quickly. If you think that you might have identified a 
vulnerability in a Cisco product, contact PSIRT:

 • Emergencies — security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which 
a severe and urgent security vulnerability should be reported. All other conditions are considered 
nonemergencies.

 • Nonemergencies — psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

 • 1 877 228-7302

 • 1 408 525-6532
x
Cisco Unity 4.1 Documentation Addendum

OL-8380-02

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html
http://www.cisco.com/go/psirt
http://www.cisco.com/en/US/products/products_psirt_rss_feed.html
mailto:security-alert@cisco.com
mailto:psirt@cisco.com


  

Preface
Obtaining Technical Assistance
Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product to encrypt any sensitive 
information that you send to Cisco. PSIRT can work from encrypted information that is compatible with 
PGP versions 2.x through 8.x. 

Never use a revoked or an expired encryption key. The correct public key to use in your correspondence 
with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page 
at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.htm

The link on this page has the current PGP key ID in use.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco 
Technical Support & Documentation website on Cisco.com features extensive online support resources. 
In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC) 
engineers provide telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and technologies. The website is 
available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com user 
ID and password. If you have a valid service contract but do not have a user ID or password, you can 
register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting 
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support & 
Documentation website by clicking the Tools & Resources link under Documentation & Tools. Choose 
Cisco Product Identification Tool from the Alphabetical Index drop-down list, or click the Cisco 
Product Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by 
product ID or model name; by tree view; or for certain products, by copying and pasting show command 
output. Search results show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the information before placing a 
service call.
xi
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Obtaining Additional Publications and Information
Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227) 
EMEA: +32 2 704 55 55 
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

 • Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo 
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/
xii
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Obtaining Additional Publications and Information
 • Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

 • Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at 
this URL:

http://www.cisco.com/packet

 • iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

 • Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

 • Networking products offered by Cisco Systems, as well as customer support services, can be 
obtained at this URL:

http://www.cisco.com/en/US/products/index.html

 • Networking Professionals Connection is an interactive website for networking professionals to share 
questions, suggestions, and information about networking products and technologies with Cisco 
experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

 • World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
xiii
Cisco Unity 4.1 Documentation Addendum

OL-8380-02

http://www.ciscopress.com
http://www.cisco.com/packet
http://www.cisco.com/go/iqmagazine
http://ciscoiq.texterity.com/ciscoiq/sample/
http://www.cisco.com/ipj
http://www.cisco.com/en/US/products/index.html
http://www.cisco.com/discuss/networking
http://www.cisco.com/en/US/learning/index.html


  

Preface
Obtaining Additional Publications and Information
xiv
Cisco Unity 4.1 Documentation Addendum

OL-8380-02



  

Ci
OL-8380-02
C H A P T E R 1

Cisco Unity Bridge Networking Guide

This chapter should be used in conjunction with the Cisco Unity Bridge Networking Guide, Release 3.0. 
New features are described in individual sections. Information that has changed in the Cisco Unity 
Bridge Networking Guide, Release 3.0—either because Cisco Unity or Cisco Unity Bridge functionality 
changed, or because the information is incorrect—is described in the “Errors” section at the end of the 
chapter.

This chapter contains the following sections:

 • Private List Considerations, page 1-1

 • Pushing Mailbox Information from the Avaya Interchange to Cisco Unity, page 1-1

 • Upgrading from Cisco Unity 4.0(5) with Bridge 3.x (Cisco Unity with IBM Lotus Domino Only), 
page 1-2

 • Errors, page 1-7

Private List Considerations
Consider notifying subscribers in the event that the following members are inadvertently removed from 
their lists:

 • When you delete a delivery location, blind addressees are removed from all private list.

 • When an external subscriber becomes a regular subscriber, the external subscriber is removed from 
all private lists.

Pushing Mailbox Information from the Avaya Interchange to 
Cisco Unity

When the Cisco Unity Bridge represents more than one node on the Octel analog network—in other 
words, the Interchange has multiple location profiles with different serial numbers configured for the 
same Cisco Unity network—the configuration of the directory view for update pushes of mailbox 
information should be performed for only one of the Cisco Unity location profiles. Otherwise, the Bridge 
will receive redundant pushes when changes occur.
1-1
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Chapter 1      Cisco Unity Bridge Networking Guide
Upgrading from Cisco Unity 4.0(5) with Bridge 3.x (Cisco Unity with IBM Lotus Domino Only)
Depending on how many location profiles are set up for Cisco Unity on the Interchange and how many 
changes are occurring, sending duplicate pushes could generate unnecessary use of Bridge ports for 
administrative calls. It could also generate unnecessary processing of duplicate modifications by 
Cisco Unity and other servers, such as a Microsoft Exchange server hosting the Voice Connector, or an 
IBM Lotus Domino server involved in routing the push messages.

Upgrading from Cisco Unity 4.0(5) with Bridge 3.x (Cisco Unity 
with IBM Lotus Domino Only)

If you currently have Cisco Unity 4.0(5) servers configured for networking with a Bridge 3.x server (or 
servers), use the task list and procedures in this section to upgrade Cisco Unity. Networking with the 
Octel servers is not disrupted after upgrading Cisco Unity. Therefore, in installations with multiple 
Cisco Unity servers, you can upgrade the Cisco Unity servers as your schedule permits.

Upgrade the Cisco Unity Bridgehead Server

1. Upgrade the Cisco Unity bridgehead server. For systems using failover, upgrade the secondary 
server as well. Refer to the “Upgrading Cisco Unity 4.x Software to the Shipping Version” chapter 
of the Cisco Unity Reconfiguration and Upgrade Guide (With IBM Lotus Domino) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/rug/dom/index.htm.

2. Run ConfigMgr.exe on the Cisco Unity bridgehead server to redesignate it as the bridgehead server. 
See the “Redesignating the Bridgehead Server” section on page 1-3.

Upgrade Non-Bridgehead Cisco Unity Servers

3. Upgrade all non-bridgehead Cisco Unity servers in the network. For systems using failover, upgrade 
the secondary servers as well. Refer to the “Upgrading Cisco Unity 4.x Software to the Shipping 
Version” chapter of the Cisco Unity Reconfiguration and Upgrade Guide (With IBM Lotus Domino) 
at http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/rug/dom/index.htm.

Optionally, Upgrade the Bridge Server(s)

If a newer version of the Bridge 3.x software is available, we recommend that you upgrade the Bridge 
software to the latest version.

4. Upgrade the Bridge server. See the “Upgrading Cisco Unity Bridge 3.x to a Newer Version 
(Optional)” section on page 1-3.

5. Install the Cisco Unity Bridge Analog Network and Node Analyzer (BANANA). See the “Installing 
the Cisco Unity Bridge Analog Network And Node Analyzer (BANANA)” section on page 1-5.

Enable Optional Features

6. Optionally, if the Bridge is at version 3.0(6) or later, enable the Bridge server to accept requests to 
push remote mailbox information. Refer to the “Enabling the Bridge to Accept Requests to Push 
Mailbox Information (Bridge 3.0(6) and Later)” section of the “Setting Up Cisco Unity and the 
Bridge for Networking” chapter in the Cisco Unity Bridge Networking Guide, Release 3.0 (With 
IBM Lotus Domino) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/bridge30/bnet/dom/index.htm.
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Upgrading the Cisco Unity Bridgehead Server
Upgrade the Cisco Unity bridgehead server. For systems using failover, upgrade the secondary server as 
well. Refer to the “Upgrading Cisco Unity 4.x Software to the Shipping Version” chapter of the 
Cisco Unity Reconfiguration and Upgrade Guide (With IBM Lotus Domino) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/rug/dom/index.htm.

Redesignating the Bridgehead Server
Run the ConfigMgr.exe utility with the Create Bridge Account option to redesignate the server as the 
bridgehead. (The CsBridgeConnector service will not start, and the Cisco Unity Administrator will not 
display Bridge-related pages until ConfigMgr.exe has been run.)

To Designate the Bridgehead Server

Step 1 On the Cisco Unity server, browse to the directory in which Cisco Unity is installed (the default location 
is CommServer).

Step 2 Double-click ConfigMgr.exe. The ConfigMgr dialog box appears.

Step 3 Click Create Bridge Account.

Step 4 Click OK in the dialog box that displays after the configuration has completed.

Step 5 Close the ConfigMgr dialog box.

Upgrading Non-Bridgehead Cisco Unity Servers
Upgrade all non-bridgehead Cisco Unity servers in the network. For systems using failover, upgrade the 
secondary servers as well. Networking with the Octel servers is not disrupted after upgrading 
Cisco Unity. Therefore, in installations with multiple Cisco Unity servers, you can upgrade the 
Cisco Unity servers as your schedule permits. Refer to the “Upgrading Cisco Unity 4.x Software to the 
Shipping Version” chapter of the Cisco Unity Reconfiguration and Upgrade Guide (With IBM Lotus 
Domino) at http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/rug/dom/index.htm.

Upgrading Cisco Unity Bridge 3.x to a Newer Version (Optional)
Optionally, upgrade the Bridge server (or servers) to the latest 3.x version.

We recommend that you upgrade when Bridge message traffic is light. To upgrade to the latest Bridge 
version from Bridge 3.0(x):

1. Disable and stop virus-scanning and Cisco Security Agent services.

2. Upgrade the Bridge software.

3. Re-enable and start virus-scanning and Cisco Security Agent services.
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To Disable and Stop Virus-Scanning and Cisco Security Agent Services

Step 1 Refer to the virus-scanning software documentation to determine the names of the virus-scanning 
services.

Step 2 On the Windows Start menu, click Programs > Administrative Tools > Services.

Step 3 Disable and stop each virus-scanning service and the Cisco Security Agent service:

a. In the right pane, double-click the service.

b. On the General tab, in the Startup Type list, click Disabled. This prevents the service from starting 
when you restart the server.

c. Click Stop to stop the service immediately.

d. Click OK to close the Properties dialog box.

Step 4 When the services have been disabled, close the Services MMC.

To Upgrade Cisco Unity Bridge 3.x to a Newer Version 

Step 1 Log on to the Bridge server by using the Windows 2000 Server Administrator account.

Step 2 Verify that the account has permission to access the Bridge Administrator.

a. Open the Bridge Administrator.

b. If you are allowed access and can view the Bridge Administrator pages, exit the Bridge 
Administrator and continue with Step 3.

Caution If you are denied access to the Bridge Administrator, do not continue, because the Bridge 
setup program will fail. You must log off and log back on using another account that is allowed 
access to the Bridge Administrator. It is possible that the account was denied access to the 
Bridge Administrator because it is not in the Access Control List of the 
<Bridge>\Starfish\Asp directory or does not have Full Control permissions to that directory. 
Access to the <Bridge>\Starfish\Asp directory may have been restricted when password 
protection was added to the Bridge Administrator as described in the “To Add Password 
Protection to the Bridge Administrator” procedure in the “Setting Up Cisco Unity and the 
Bridge for Networking” chapter of the Cisco Unity Bridge Networking Guide (With IBM Lotus 
Domino) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/bridge30/bnet/dom/index.ht
m.

Step 3 On the Windows Start menu, click Programs > Administrative Tools > Services, and stop the 
following two services:

 • Digital Networking

 • Unity Bridge

The Bridge services will complete the shutdown process when the last in-process message transmission 
or reception, rather than call, is complete. No additional message transmissions will begin on the 
in-process calls—either outbound or inbound—after shutdown has been initiated.
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Step 4 If you downloaded the Bridge software from the Software Center website, browse to the directory in 
which the files were extracted.

If you are using the Cisco Unity Bridge CD, insert the disc in the CD-ROM drive, and browse to the 
Install directory.

Step 5 Double-click Setup.exe.

Step 6 Click Next.

Step 7 In the Choose Destination Location dialog box, change the installation directory, if applicable, and click 
Next.

Step 8 If a device driver service was previously installed for the Brooktrout voice-fax card, a message asks if 
you want to overwrite the existing service. Click Yes twice.

Step 9 In the Select Country dialog box, select the country for which the voice-fax cards will be configured, 
and click Next.

Step 10 Verify the installation settings, and click Next.

Step 11 When prompted, remove the disc from the CD-ROM drive.

Step 12 Click OK to restart the server.

To Re-Enable and Start Virus Scanning and Cisco Security Agent Services

Step 1 Refer to the virus-scanning software documentation to determine the names of the virus-scanning 
services.

Step 2 On the Windows Start menu, click Programs > Administrative Tools > Services.

Step 3 Re-enable and start each virus-scanning service and the Cisco Security Agent service:

a. In the right pane, double-click the service.

b. On the General tab, in the Startup Type list, click Automatic to re-enable the service.

c. Click Start to start the service.

d. Click OK to close the Properties dialog box.

Step 4 When the services have been re-enabled, close the Services MMC.

Installing the Cisco Unity Bridge Analog Network And Node Analyzer 
(BANANA)

BANANA is a stand-alone application that runs on the Bridge server. It is designed to assist with 
monitoring and troubleshooting analog communication between the Bridge and the Octel nodes in the 
analog network. It also provides detail and summary information of call activity.

The drive on which BANANA will be installed requires at least 1 GB of free disk space.

The following procedures provide details for installing and initiating test calls. Refer to the BANANA 
Help file for information about other functionality provided by BANANA.
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To Install BANANA

Step 1 Disable virus scanning services and the Cisco Security Agent service, if applicable.

Step 2 Insert the Cisco Unity Bridge compact disc in the CD-ROM drive, and browse to the BANANA 
directory.

Step 3 Double-click setup.exe.

Step 4 Click OK at the welcome screen.

Step 5 If applicable, change the directory where BANANA will be installed.

Step 6 Click the Installation button.

Step 7 If applicable, change the program group where BANANA will appear.

Step 8 Click Continue.

Step 9 If a Version Conflict message box is displayed warning that a file being copied is not newer than the file 
on your system, click Yes to keep the existing file.

Step 10 When the installation is done, click OK.

Step 11 Enable virus-scanning and the Cisco Security Agent services, if applicable

Note The most up-to-date version of BANANA is available at http://www.CiscoUnityTools.com. 
When you start BANANA, it checks the CiscoUnityTools website to see if a newer version is 
available, and if so, prompts you about upgrading.

To Adjust the Message Delivery Window Settings

Step 1 In the Bridge Administrator, click Octel Nodes.

Step 2 In the Node list, click an Octel node that you want to be tested, and click Edit.

Step 3 On the Octel Node page in the Message Delivery Windows section, adjust the schedule according to 
following illustration, so that the Bridge will not wait to initiate calls to the Octels to deliver normal, 
urgent, and administrative messages.

Note that BANANA makes only administrative calls when testing the Octel analog network. However, 
if you adjust the normal and urgent schedules as shown, you do not have to remember to adjust the 
schedule if you also send test messages from Cisco Unity subscribers to Octel subscribers.

Step 4 Click Save.
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Step 5 Repeat Step 2 through Step 4 for each Octel node that you want to test.

To Initiate Test Calls to the Octel Nodes

Step 1 On the Bridge server on the Windows Start menu, click Programs > BANANA > BANANA admin. The 
BANANA admin main window displays.

Step 2 Configure the log and output folder locations.

Step 3 Specify the Octel nodes to be included when placing test calls.

Step 4 Place the test calls.

Step 5 Process the call data, and view the results.

Refer to the BANANA Help for details.

Errors

Configuring the Interop Gateway (Cisco Unity with IBM Lotus Domino Only)
In the Cisco Unity Bridge Networking Guide, Release 3.0 (With IBM Lotus Domino), the procedures for 
setting up Cisco Unity and the Bridge for networking omit an additional step for configuring permissions 
for the interop gateway that is required when Cisco Unity is integrated with IBM Lotus Domino 
release 7.0. The step must be done prior to performing the procedure to configure the interop gateway.

In Domino release 7.0, the default permissions set for the -Default- account on the access control list of 
the mailbox.ntf template do not include permission to replicate or copy documents. This permission is 
required when setting up the interop gateway. It can be granted either by adding the permission for the 
-Default- account, or by adding the UnityServers group that was created during Cisco Unity installation 
to the access control list, and granting permission to replicate or copy documents to the group. Refer to 
the applicable IBM Lotus documentation for information on adding this permission.
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Cisco Unity Failover Configuration and 
Administration Guide

This chapter should be used in conjunction with the Cisco Unity Failover Configuration and 
Administration Guide (With IBM Lotus Domino), Release 4.0(5) and Later and with the Cisco Unity 
Failover Configuration and Administration Guide (With Microsoft Exchange), Release 4.x. New features 
are described in individual sections. Information that has changed in the Cisco Unity Failover 
Configuration and Administration Guide—either because Cisco Unity functionality changed or because 
the information is incorrect—is described in the “Errors” section at the end of the chapter.

This chapter contains the following sections:

 • Effects on Cisco Unity Web Applications When Failover or Failback Occurs, page 2-1

 • Using Cisco Unity Failover with Integrations via PIMG Units, page 2-2

 • Errors, page 2-5

Effects on Cisco Unity Web Applications When Failover or 
Failback Occurs

Subscribers must use the correct URLs to access the Cisco Unity Administrator, Status Monitor, and the 
Cisco Personal Communications Assistant (PCA) on the active server. When failover or failback occur 
and subscribers use the URL for the inactive server to browse to a Cisco Unity web application, 
Cisco Unity does not automatically redirect them to the active server. 

Subscribers can continue to access Cisco Unity web applications on the inactive server, but the 
applications do not work as expected: 

 • When subscribers access the Cisco Unity Administrator on the inactive server, they are not allowed 
to save changes. 

 • When subscribers access the Cisco PCA on the inactive server, any changes they make in the 
Cisco Unity Assistant can be saved, but the changes are not replicated on the active server and are 
then overwritten when failover or failback occurs.

In contrast, subscribers who use the phone as a recording or playback device for the Media Master 
control bar can continue to do so without having to manually update it with the applicable server name. 
This is because when failover or failback occurs, the Media Master automatically directs the request to 
place the call to the active server, regardless of the URL that the subscriber used to access the 
Cisco Unity web application.
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Note that depending on the application and how the Cisco Unity server is set up, the server name that is 
displayed in the Media Master may not be updated, but that does not prevent the correct server from 
placing the call. For example, the server name displayed in the Media Master that appears in the 
Cisco Unity Administrator and with Cisco Unity ViewMail for Microsoft Outlook does not change. 
When failover or failback occur, the name displayed is the one that the subscriber entered when they set 
up the Media Master to use the phone as a recording or playback device. The same is true for the 
Cisco PCA when you prevent the Media Master from being set up automatically. (You can use the 
Advanced Settings Tool to change the default setting for the Unity Inbox and Assistant—Automatically 
Set Up TRAP in Media Master.) Otherwise, the server name displayed in the Media Master that appears 
in the Cisco PCA reflects the server that subscribers browsed to when they entered the URL for the 
Cisco PCA.

Using Cisco Unity Failover with Integrations via PIMG Units
For Cisco Unity 4.1(x) and later, integrations via PIMG units support failover. The following sections 
provide only the new information about these integrations. Use this information with the information in 
the Cisco Unity Failover Configuration and Administration Guide to understand failover for integrations 
via PIMG units.

 • The Force Failover Setting Must Be Checked, page 2-2

 • Preparing for Manual or Scheduled Failback (Integrations via PIMG Units Only), page 2-2

 • How Failover Works When Cisco Unity Is Integrated via PIMG Units, page 2-3

 • Effects of Failover and Failback on Calls in Progress, page 2-4

 • Intervals for Failover and Failback, page 2-4

 • Causes of Both Servers Becoming Active at the Same Time, page 2-5

The Force Failover Setting Must Be Checked
For integrations via PIMG units, the Force Failover If Call Arrives on Inactive Secondary check box in 
the Failover Monitor must be checked so that failover can function correctly. If this check box is not 
checked, failover will not function correctly.

If you customize failover settings in the Failover Monitor, confirm that Force Failover If Call Arrives on 
Inactive Secondary check box remains checked.

Preparing for Manual or Scheduled Failback (Integrations via PIMG Units Only)
When Cisco Unity is integrated with a circuit-switched phone system via PIMG units and you want 
failback to occur (the secondary server is currently active), do the following procedure before the 
secondary server fails back to the primary server.

To Disable Failover Initiation When Calls Are Unanswered on the Primary Server

Step 1 On the secondary server, on the Windows Start menu, click Programs > Cisco Unity > Failover 
Monitor.

Step 2 Click Configure.
2-2
Cisco Unity 4.1 Documentation Addendum

OL-8380-02



  

Chapter 2      Cisco Unity Failover Configuration and Administration Guide
Using Cisco Unity Failover with Integrations via PIMG Units
Step 3 Uncheck the Force Failover If Call Arrives on Inactive Secondary check box.

Step 4 Click OK.

Approximately 10 seconds after the primary server becomes active and failback occurs, do the following 
procedure.

To Enable Failover Initiation When Calls Are Unanswered on the Primary Server

Step 1 On the secondary server, on the Windows Start menu, click Programs > Cisco Unity >Failover 
Monitor.

Step 2 Click Configure.

Step 3 Check the Force Failover If Call Arrives on Inactive Secondary check box.

Step 4 Click OK.

How Failover Works When Cisco Unity Is Integrated via PIMG Units
Figure 2-1 shows a failover configuration for a circuit-switched phone system in an integration via PIMG 
units.

Figure 2-1 Failover Configuration for a Circuit-Switched Phone System Integrated via PIMG 

Units

In this integration, the PIMG units control when failover is initiated by sensing that the primary server 
is not responding. If the primary server is unresponsive, the PIMG units will direct calls to the secondary 
server, which will become active.

After a failure of the primary server occurs and before the secondary server becomes active, subscribers 
will hear a ringback tone or will be transferred to an attendant when they dial the internal phone number 
to log on to Cisco Unity by phone. When the secondary server becomes active, Cisco Unity functions 
normally.

You can configure the secondary server to initiate failback daily. When failback succeeds, the primary 
server becomes the active server again. Alternatively, you can configure failover so that the secondary 
server fails back only when you manually initiate failback by using the Failover Monitor. However, 
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integrations that use PIMG units require temporarily unchecking the Force Failover If Call Arrives on 
Inactive Secondary check box when failback occurs. For instructions, see the “Preparing for Manual or 
Scheduled Failback (Integrations via PIMG Units Only)” section on page 2-2.

Effects of Failover and Failback on Calls in Progress
When failover or failback is initiated, calls in progress are maintained or dropped as described in the 
Cisco Unity Failover Configuration and Administration Guide and in the following section, “Intervals 
for Failover and Failback.”

Intervals for Failover and Failback

Failover Interval

When failover occurs, the time it takes for the secondary server to begin answering calls typically 
depends on what causes failover as described in Table 2-1.

Failback Interval

When failback occurs, the time it takes for the primary server to begin answering calls typically depends 
on what causes failback as described in Table 2-2. File replication occurs in the background and does 
not affect the failback interval.

Table 2-1 Interval for Failover 

Failover Cause Time

Manual failover  • For integrations via PIMG units, calls are redirected to the extension 
of an attendant to be answered manually for approximately ten 
seconds, then the secondary server begins answering calls.

Network outage  • For integrations via PIMG units, calls in progress may be dropped, 
depending on the nature of the network outage.

Failure of the AvCsMgr 
service on the primary 
server

 • The secondary server begins answering calls immediately.

 • Calls in progress on the primary server are dropped.

Failure of the 
operating system 
on the primary server

 • The secondary server begins answering calls after waiting for the 
number of keep-alive events set in the Missed Events Before Failover 
field in the Failover Monitor. The time required depends on the value 
of the field and on the value of the Interval (ms) field. The default 
settings for the fields result in a 30-second delay for the secondary 
server to become active.

 • Calls in progress on the primary server are dropped.

Inactive secondary server 
answers a call

 • The secondary server begins answering calls immediately.

 • Calls in progress on the primary server are not dropped but are 
maintained until the callers hang up.
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Causes of Both Servers Becoming Active at the Same Time
Under some circumstances, both the primary server and secondary server can become active at the same 
time, as indicated in the Failover Monitor. The condition can occur when the network connection to the 
primary server is lost, so both servers become active. For integrations via PIMG units, Cisco Unity will 
receive no calls. However, if the primary server loses its connection to the PIMG units while the 
secondary server retains its connection, calls can reach the secondary server and initiate failover.

Errors
The following section applies to the Cisco Unity Failover Configuration and Administration Guide (With 
IBM Lotus Domino), Release 4.0(5) and Later at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/dom/index.htm and to the 
Cisco Unity Failover Configuration and Administration Guide (With Microsoft Exchange), Release 4.x 
at http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/ex/index.htm.

Notifying Subscribers to Update the Server Name in the Media Master
The “Notifying Subscribers to Update the Server Name in the Media Master” section in the “Tasks 
Required When Failover or Failback Occurs” chapter of the Cisco Unity Failover Configuration and 
Administration Guide is not applicable to a 4.1 system. Disregard the information.

Table 2-2 Interval for Failback 

Failback Cause Time

Automatic failback, 
and the primary server 
is on but inactive

 • For integrations via PIMG units, the primary server begins answering 
calls as soon as the PIMG units re-establish their connection to the 
primary server (in approximately ten seconds).

Manual failback, 
and the primary server 
is on but inactive

 • For integrations via PIMG units, the primary server begins answering 
calls as soon as the PIMG units re-establish their connection to the 
primary server (in approximately ten seconds).

Failure of the AvCsMgr 
service on the secondary 
server, and the primary 
server is on but inactive

 • For integrations via PIMG units, the primary server begins answering 
calls as soon as the PIMG units re-establish their connection to the 
primary server (in approximately ten seconds).

Failure of the 
operating system 
on the secondary server, 
and the primary server is on 
but inactive

 • For integrations via PIMG units, the primary server begins answering 
calls as soon as the PIMG units re-establish their connection to the 
primary server (in approximately ten seconds).
2-5
Cisco Unity 4.1 Documentation Addendum

OL-8380-02

http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/dom/index.htm
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/ex/index.htm


  

Chapter 2      Cisco Unity Failover Configuration and Administration Guide
Errors
2-6
Cisco Unity 4.1 Documentation Addendum

OL-8380-02



  

Ci
OL-8380-02
C H A P T E R 3

Cisco Unity Installation Guide

This chapter should be used in conjunction with the Release 4.0(5) and Later versions of the Cisco Unity 
installation guide. New features are described in individual sections. Information that has changed in the 
Cisco Unity installation guide—either because Cisco Unity functionality changed or because the 
information is incorrect—is described in the “Errors” section at the end of the chapter.

This chapter contains the following sections:

 • Cisco Unity 4.1(1) Is Available Only in U.S. English, page 3-1

 • Installing Windows Server 2003 Service Pack 1, page 3-1

 • Setting Required Exchange Permissions, page 3-2

 • Setting Rights and Permissions with the Cisco Unity Permissions Wizard (Exchange 2003 and 
Exchange 2000): When and Where Are the Unity and Locations OUs Created?, page 3-2

 • Starting the Cisco Unity Administrator or Status Monitor When SSL Is Configured, page 3-3

 • Errors, page 3-4

Cisco Unity 4.1(1) Is Available Only in U.S. English
Cisco Unity version 4.1(1) is available only in U.S. English (ENU). You can install Cisco Unity 4.1(1) 
only on a server on which the U.S. English version of Windows 2000 Server or Windows Server 2003 is 
installed. You cannot change the locale of Windows to a setting other than English (United States).

All other languages, including TTY English (ENX), are not available for use with Cisco Unity 4.1(1).

You cannot upgrade an existing Cisco Unity system that is using a language other than U.S. English to 
version 4.1(1).

Installing Windows Server 2003 Service Pack 1
Windows Server 2003 Service Pack 1 has been qualified for use with Cisco Unity 4.x. Service Pack 1 is 
not required to install Cisco Unity 4.1, but we recommend that you install it because of the improvements 
to Windows security that it includes.

Caution Windows Server 2003 Service Pack 1 includes a firewall. Do not enable the firewall, or Cisco Unity will 
not function correctly.
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To Install Windows Server 2003 Service Pack 1

Step 1 Log on to the Cisco Unity server by using an account that has the right to install software.

Step 2 Insert Cisco Unity Service Pack CD 4 into the CD-ROM drive.

Step 3 On the CD, browse to the directory Windows Server 2003 SP1\i386\update.

Step 4 Double-click update.exe.

Step 5 Follow the on-screen prompts.

Setting Required Exchange Permissions
In previous versions of Cisco Unity, you were required to delegate Exchange Admin control to the 
installation account and delegate Exchange Admin or Exchange View Only Admin control to the 
directory services account at the Exchange organization level. You now can delegate control to those 
accounts at the administrative group level. However, for ease of maintenance, we still encourage you to 
delegate control at the organization level.

If you have multiple Cisco Unity servers and you want to use Digital Networking, for all administrative 
groups in which Cisco Unity subscriber mailboxes are homed, you must delegate the following controls:

 • Exchange Administrator control to the installation account for every Cisco Unity server. 

 • Exchange Administrator or Exchange View Only Administrator control to the directory service 
account for every Cisco Unity server. 

Otherwise, Digital Networking is not supported.

Using Cisco Unity Bridge Networking, AMIS Networking, or VPIM Networking is supported only when 
you delegate control to the installation and directory services accounts at the organization level.

For documentation on delegating control at the administrative group level, refer to the Permissions 
wizard Help file, PWHelpExchange_<language>.htm.

Setting Rights and Permissions with the Cisco Unity 
Permissions Wizard (Exchange 2003 and Exchange 2000): When 
and Where Are the Unity and Locations OUs Created?

When Cisco Unity uses an Exchange 2003 or Exchange 2000 server as the partner server, the 
Permissions wizard automatically creates an organizational unit (OU) named Unity at the top level of 
the Active Directory domain that contains the Cisco Unity server. The Permissions wizard also creates 
an OU named Locations below the Unity OU. 

During the Permissions wizard, you are prompted to choose the OU where you want Cisco Unity to 
create location objects. This dialog box defaults to the Unity/Locations OU, which has already been 
created by the Permissions wizard. If you choose a different location, the Unity and Locations OUs are 
not deleted.

The Permissions wizard creates Unity and Locations OUs only once in a domain. If you rerun the 
Permissions wizard, either on the same server or on another server (for example, because you are adding 
another Cisco Unity server to the same domain), the Permissions wizard does not create additional OUs. 
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Starting the Cisco Unity Administrator or Status Monitor When 
SSL Is Configured

When you use the Cisco Unity tray icon or desktop icons to start the Cisco Unity Administrator or the 
Status Monitor, the default URL is an HTTP URL. If you have set up the Cisco Unity Administrator and 
Status Monitor to use SSL, you need to do the following tasks:

 • Update the Windows registry to change the default URL to an HTTPS (secure) URL for the tray 
icon.

 • Change the desktop icons to use HTTPS URLs.

Do the applicable procedure, depending on the access method you want to use:

 • To Access the Cisco Unity Administrator and Status Monitor by Using the Cisco Unity Tray Icon 
When SSL Is Configured, page 3-3

 • To Access the Cisco Unity Administrator and Status Monitor by Using the Desktop Icons When SSL 
Is Configured, page 3-3

To Access the Cisco Unity Administrator and Status Monitor by Using the Cisco Unity Tray Icon When SSL Is 
Configured

Step 1 On the Cisco Unity server, start Registry Editor.

Caution Changing the wrong registry key or entering an incorrect value can cause the server to 
malfunction. Before you edit the registry, confirm that you know how to restore it if a problem 
occurs. (Refer to the “Restoring” topics in Registry Editor Help.) If you have any questions 
about changing registry key settings, contact Cisco TAC.

Step 2 If you do not have a current backup of the registry, click Registry > Export Registry File, and save the 
registry settings to a file.

Step 3 Expand the key HKEY_LOCAL_MACHINE\SOFTWARE\Active Voice\SystemParameters\1.0.

Step 4 In the left pane, right-click 1.0, and click New > DWORD Value.

Step 5 Name the value EnforceSSL.

Step 6 In the right pane, double-click EnforceSSL.

Step 7 Change Value Data to 1. 

Step 8 Click OK to save the change.

Step 9 Close Registry Editor.

Step 10 Restart the server.

To Access the Cisco Unity Administrator and Status Monitor by Using the Desktop Icons When SSL Is Configured

Step 1 On the Cisco Unity server, right-click the System Administration desktop icon, and click Properties.

Step 2 Click the Web Document tab.

Step 3 In the URL field, change the “http” portion of the URL to https.
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Step 4 Click OK.

Step 5 Right-click the Status Monitor desktop icon, and click Properties.

Step 6 Click the Web Document tab.

Step 7 In the URL field, change the “http” portion of the URL to https.

Step 8 Click OK.

Errors
The following section applies to the Installation Guide for Cisco Unity Unified Messaging with 
Microsoft Exchange 2003/2000 (With Failover Configured), Release 4.0(5) and Later at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/inst/inst405/5ue2k3f/index.ht
m and to the Installation Guide for Cisco Unity Unified Messaging with Microsoft Exchange 2003/2000 
(Without Failover), Release 4.0(5) and Later at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/inst/inst405/5ue2k3nf/index.h
tm.

Service Pack CD for Exchange 2003 SP 1 (Cisco Unity Unified Messaging with 
Microsoft Exchange 2003/2000 Only)

The Cisco Unity Installation Guide tells you to install Exchange 2003 Service Pack 1 from 
Cisco Unity Service Pack CD 2. Exchange 2003 SP 1 is actually on Cisco Unity Service Pack CD 3.
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Cisco Unity Maintenance Guide

This chapter should be used in conjunction with the Cisco Unity Maintenance Guide, Release 4.0(5). 
Information that has changed in the Cisco Unity Maintenance Guide, Release 4.0(5)—either because 
Cisco Unity functionality changed or because the information is incorrect—is described in the “Errors” 
section.

This chapter contains the following section:

 • Errors, page 4-1

Errors
The following sections apply to the Cisco Unity Maintenance Guide (With IBM Lotus Domino), Release 
4.0(5) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/maint/maint405/dom/index.ht
m and to the Cisco Unity Maintenance Guide (With Microsoft Exchange), Release 4.0(5) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/maint/maint405/ex/index.htm, 
unless otherwise noted.

 • Unity Messaging System Mailbox (Cisco Unity with Microsoft Exchange Only), page 4-1

 • Updating the System Clock, page 4-2

Unity Messaging System Mailbox (Cisco Unity with Microsoft Exchange Only)
The “Moving the Unity Messaging System, UAmis, UVPIM, UOmni, and USbms Exchange Mailboxes” 
section in the “Cisco Unity Data and Log Files” chapter of the Cisco Unity Maintenance Guide contains 
an incorrect procedure for moving the Unity Messaging System Mailbox. Disregard the “Unity 
Messaging System Mailbox (Cisco Unity with Microsoft Exchange Only)” section.

The Unity Messaging System mailbox should always reside on the partner Exchange server. To move the 
mailbox to a different Exchange server, you must do so by changing the partner Exchange server. If you 
attempt to move the mailbox to another server by using the procedure in the Cisco Unity Maintenance 
Guide without following the steps to change the partner Exchange server, when you attempt to restart 
the Cisco Unity software, the Unity services may generate errors and fail to start.

For the procedure to change the partner Exchange server, refer to the “Changing the Partner Exchange 
Server” chapter of the Cisco Unity Reconfiguration and Upgrade Guide (With Microsoft Exchange) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/rug/ex/index.htm. When the partner 
Exchange server is changed, the Unity Messaging System mailbox is automatically moved.
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Updating the System Clock
The “Updating the System Clock” section in the “Routine and Scheduled Maintenance on the 
Cisco Unity Server” chapter of the Cisco Unity Maintenance Guide should contain the following 
information:

If you change the time on the system clock, restart the Cisco Unity server or Cisco Unity may not 
function properly.

Note You do not need to restart the server when Windows automatically resets the system clock for daylight 
saving time.
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Cisco Unity Reconfiguration and Upgrade Guide

This chapter should be used in conjunction with the Cisco Unity Reconfiguration and Upgrade Guide. 
New features are described in individual sections. Information that has changed in the Cisco Unity 
Reconfiguration and Upgrade Guide—either because Cisco Unity functionality changed or because the 
information is incorrect—is described in the “Errors” section at the end of the chapter.

This chapter contains the following sections:

 • Changing the Accounts That Cisco Unity Services Log On As (Failover Configuration Only), page 
5-1

 • Upgrading to Cisco Unity 4.1(1) Is Not Supported on a System Using a Language Other Than U.S. 
English, page 5-4

 • Using the Intel Dialogic D/120JCT-Euro Rev 2 Voice Card, page 5-4

 • Errors, page 5-6

Changing the Accounts That Cisco Unity Services Log On As 
(Failover Configuration Only)

When Cisco Unity is configured for failover and you are changing the accounts that Cisco Unity services 
log on as, you must do the following procedure to ensure that both the primary and secondary 
Cisco Unity servers are configured correctly.

To Change the Accounts That Cisco Unity Services Log On As (Failover Configuration Only)

Step 1 Create the new accounts, and run the Cisco Unity Permissions wizard. If Exchange is the message store, 
set Exchange permissions. 

For more information, refer to the “Creating Accounts for the Installation and Setting Rights and 
Permissions” chapter of the applicable Release 4.0(5) and Later Cisco Unity installation guide at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

Step 2 If the primary server is active skip to Step 3. 

If the secondary server is active, fail back to the primary server:

a. On the secondary server, on the Windows Start menu, click Programs > Cisco Unity > Failover 
Monitor.

b. Click Failback.
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c. Click OK to confirm that you want to fail back to the primary server. The primary server becomes 
active, and the secondary server becomes inactive.

d. Close the Failover Monitor.

Step 3 In the Cisco Unity Reconfiguration and Upgrade Guide, refer to Appendix B, “Cisco Unity 4.x 
Services,” and make a list of the services that log on as the applicable account(s) for your configuration:

The Domino version of the guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/rug/dom/index.htm. The Exchange 
version of the guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/rug/ex/index.htm.

Step 4 On the primary server, on the Windows Start menu, click Programs > Administrative Tools > Services.

Step 5 Right-click the first of the services that you identified in Step 3, and click Properties.

Step 6 Click the Log On tab.

Step 7 Enter the applicable account for the service, and enter and confirm the password for that account.

Step 8 Repeat Step 5 through Step 7 until you have changed the logon account for all of the services that you 
identified in Step 3.

Step 9 On the secondary server, on the Windows Start menu, click Programs > Administrative Tools > 
Services.

Step 10 Right-click the first of the services that you identified in Step 3, and click Properties.

Step 11 Click the Log On tab.

Step 12 Enter the applicable account for the service, and enter and confirm the password for that account.

Step 13 Repeat Step 10 through Step 12 until you have changed the logon account for all of the services that you 
identified in Step 3.

Step 14 On the secondary server, browse to the CommServer directory.

Step 15 Right-click the CommServer\Snapshot directory and click Sharing.

Step 16 On the Sharing tab, click Permissions.

Step 17 In the Permissions for <directory> dialog box, click Add.

Step 18 In the Select Users, Computer, or Groups dialog box, click the account that owns failover, click Add, 
and click OK. to close the dialog box. 

Step 19 In the Permissions for <directory>, click the name of the account that owns failover.

Table 1 Accounts that Cisco Unity Directory and Message Store Services Log on As

Message Store Partner Exchange Server
Make a List of the Services that 
Log on As the Following Accounts

Exchange Exchange 2003 or Exchange 2000  • Directory services account, 
UnityDirSvc

 • Message store services account, 
UnityMsgStoreSvc

Exchange Exchange 5.5 Directory and message store services 
account, UnitySvc

Domino Not applicable Directory and message store services 
account, UnitySvc
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Step 20 In the Permissions list, check Full Control and Change.

Step 21 In the Permissions for <directory> dialog box, click OK to close the dialog box.

Step 22 In the <directory> Properties dialog box, click OK.

Step 23 Repeat Step 15 through Step 22 for the following four directories:

 • CommServer\Support

 • CommServer\UnityMTA

 • CommServer\Localize\DefaultConfiguration

 • CommServer\Localize\Prompts

Step 24 Run the failover configuration wizard on the primary server:

a. In Windows Explorer, browse to the CommServer directory.

b. Double-click FailoverConfig.exe to start the Configure Cisco Unity Failover wizard.

c. On the Welcome page, click Next.

d. On the Specify Server Role page, click Primary Server, if available, and click Next.

e. On the Enter the Name of Your Server page, click Browse, select the name of the secondary server, 
and click OK. The IP address for the secondary server is filled in automatically.

f. Click Next.

g. On the Enter Failover Account Information page, click Browse, and double-click the name of the 
messaging account. This account will own the failover service.

The account you select must have the right to act as part of the operating system and to log on as a 
service, and must be a member of the local Administrators group.

Caution You must specify the same account on both the primary and secondary servers.

h. In the Password field, enter the password for the account that owns the failover service, and click 
Next.

i. On the Begin Configuring Your Server page, click Configure. The wizard verifies settings and 
configures failover on the primary server.

If the wizard does not finish the configuration successfully, an error message explains why the 
wizard failed. Exit the wizard, correct the problem, and click Configure again.

j. On the Completing page, click Finish.

Step 25 Run the failover configuration wizard on the secondary server:

a. On the Windows taskbar, double-click the system clock. The Date/Time Properties dialog box 
appears.

b. Set the time to the same hour and minute as shown on the primary server, and click OK.

c. In Windows Explorer, browse to the CommServer directory.

d. Double-click FailoverConfig.exe to start the Configure Cisco Unity Failover wizard.

e. On the Welcome page, click Next.

f. On the Specify Server Role page, click Secondary Server, and click Next.

g. On the Enter the Name of Your Server page, click Browse, select the name of the primary server, 
and click OK. The IP address for the primary server is filled in automatically.
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h. Click Next.

i. On the Enter Failover Account Information page, click Browse, and double-click the name of the 
messaging account. This account will own the failover service.

The account you select must have the right to act as part of the operating system and to log on as a 
service, and must be a member of the local Administrators group.

Caution You must specify the same account on the both the primary and secondary servers.

j. In the Password field, enter the password for the account that owns the failover service, and click 
Next.

k. On the Begin Configuring Your Server page, click Configure. The wizard verifies settings and 
configures failover on the secondary server.

If the wizard does not finish the configuration successfully, an error message explains why the 
wizard failed. Exit the wizard, correct the problem, and click Configure again.

l. On the Completing page, click Finish.

Upgrading to Cisco Unity 4.1(1) Is Not Supported on a System 
Using a Language Other Than U.S. English

Cisco Unity version 4.1(1) is available only in U.S. English (ENU). You cannot upgrade an existing 
Cisco Unity system that is using a language other than U.S. English to version 4.1(1). 

All other languages, including TTY English (ENX), are not available for use with Cisco Unity 4.1(1).

You can install Cisco Unity 4.1(1) only on a server on which the U.S. English version of Windows 2000 
Server or Windows Server 2003 is installed. You cannot change the locale of Windows to a setting other 
than English (United States).

Using the Intel Dialogic D/120JCT-Euro Rev 2 Voice Card
Some Cisco Unity versions require additional Intel Dialogic software when the D/120JCT-Euro Rev 2 
voice card is installed. Table 2 indicates whether the .prm files are required for a newly installed, 
upgraded, or existing Cisco Unity system.

A procedure for installing the .prm files, if applicable, follows the table.
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To Install Additional Dialogic Software for the Dialogic D/120JCT-Euro Rev 2 Voice Card

Step 1 On a secure server, go to the Other Cisco Unity Components Software Download page at 
http://www.cisco.com/cgi-bin/tablebuild.pl/unity, and download the file DialogicD120JCTEuro.exe.

Note To access the software download page, you must be logged on to Cisco.com as a registered user.

Step 2 Click the file DialogicD120JCTEuro.exe.

Step 3 When the download is complete, copy the file DialogicD120JCTEuro.exe to the Cisco Unity server.

Step 4 On the Cisco Unity server, in Windows Explorer, double-click DialogicD120JCTEuro.exe.

Step 5 Follow the on-screen prompts to extract the following three files to the directory 
Commserver\Dialogic\Data:

 • nz_120jr2.prm

 • au_120jr2.prm

 • eu_120jr2.prm

Step 6 Right-click the Cisco Unity icon in the status area of the taskbar, and click Stop Cisco Unity.

Step 7 On the Windows Start menu, click Programs > Dialogic System Software > Dialogic Configuration 
Manager - DCM.

Step 8 On the Dialogic Configuration Manager Service menu, click Stop Service.

Table 2 Compatibility of Cisco Unity and Dialogic D/120JCT-Euro Rev 2 Voice Cards 

Cisco Unity Version Compatibility with D/120JCT-Euro Rev 2 Voice Cards

New Cisco Unity 
4.0(5) system

Automatic. 

Cisco Unity 4.0(5) 
system upgraded 
from Cisco Unity 
4.0(1) through 4.0(4)

Requires additional Dialogic software. See the “To Install Additional Dialogic 
Software for the Dialogic D/120JCT-Euro Rev 2 Voice Card” procedure on 
page 5-5. 

The upgrade process documented in the Cisco Unity Reconfiguration and 
Upgrade Guide does not require reinstalling Dialogic software. Therefore, the 
required .prm files, which are installed automatically with the rest of the 
Dialogic software when you install the Cisco Unity 4.0(5) software, are not 
installed when you upgrade a 4.0(x) system to 4.0(5).

Cisco Unity 4.0(5) 
system upgraded 
from version 3.x

Automatic.

The upgrade process documented in the Cisco Unity Reconfiguration and 
Upgrade Guide requires reinstalling Dialogic software. Therefore, the required 
.prm files are installed automatically with the rest of the Dialogic software 
when you install the Cisco Unity 4.0(5) software.

Cisco Unity 4.0(1) 
through 4.0(4) 
system

Requires additional Dialogic software. See the “To Install Additional Dialogic 
Software for the Dialogic D/120JCT-Euro Rev 2 Voice Card” procedure on 
page 5-5.

Cisco Unity 3.x 
system

Not compatible. The system must be upgraded to Cisco Unity 4.0(5).
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Step 9 On the Dialogic Configuration Manager Service menu, click Start Service.

Stopping and restarting the service forces the Rev 2 card(s) to download the updated .prm files.

Step 10 On the Windows Start menu, click Programs > Startup > AvCsTrayStatus to restart the Cisco Unity 
icon.

Step 11 When the Cisco Unity icon appears in the status area of the taskbar, right-click it.

Step 12 Click Start Cisco Unity.

Errors
The following section applies to the Cisco Unity Reconfiguration and Upgrade Guide (With IBM Lotus 
Domino) at http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/rug/dom/index.htm and to 
the Cisco Unity Reconfiguration and Upgrade Guide (With Microsoft Exchange) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/rug/ex/index.htm.

Cisco Unity 4.x Services
In the “Cisco Unity 4.x Services” appendix of the Cisco Unity Reconfiguration and Upgrade Guide, the 
following service should be included in the Exchange 2003/2000 and Exchange 5.5 tables, and in the 
Domino table: 

Upgrading a Cisco Unity 2.x System to the Shipping Version
The “Upgrading a Cisco Unity 2.x System to the Shipping Version” chapter of the Cisco Unity 
Reconfiguration and Upgrade Guide implies that you can upgrade directly from Cisco Unity 2.x to the 
shipping version. However, if you are upgrading from Cisco Unity 2.x and you want to export subscriber 
data from Cisco Unity 2.x and import it into Cisco Unity 4.x, you must:

1. Upgrade to Cisco Unity 4.0(4) and import the data as documented in the “Upgrading a Cisco Unity 
2.x System to the Shipping Version” chapter.

Cisco Unity4.0(4) is available on the Cisco Unity Archives download page at 
http://www.cisco.com/cgi-bin/tablebuild.pl/unity-archives.

2. Upgrade to the shipping version as documented in the “Upgrading Cisco Unity 4.x Software to the 
Shipping Version” chapter, also in the Cisco Unity Reconfiguration and Upgrade Guide.

The application that imports data from Cisco Unity 2.x works correctly only through version 4.0(4).

If you want to upgrade without exporting subscriber data from Cisco Unity 2.x, you can follow the 
documentation in the “Upgrading a Cisco Unity 2.x System to the Shipping Version” chapter to upgrade 
directly to the shipping version.

Service Logs On As Startup Mode Comments Dependencies

TomCat Local System Automatic None None
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This chapter should be used in conjunction with the Cisco Unity System Administration Guide, Release 
4.0(5). New features are described in individual sections. Information that has changed in the 
Cisco Unity System Administration Guide, Release 4.0(5)—either because Cisco Unity functionality 
changed or because the information is incorrect—is described in the “Errors” section at the end of the 
chapter.

This chapter contains the following sections:

 • Allowing Subscribers to Access Cisco Unity by Phone Without Entering a Password, page 6-2

 • Changing How Cisco Unity Handles Messages That Contain Text (Cisco Unity with Exchange), 
page 6-2

 • Disabling Delete Confirmations in the Cisco Unity Inbox (Cisco Unity with Exchange Only), page 
6-10

 • Disabling the “Record Your Message at the Tone” Prompt, page 6-10

 • Disabling the “Wait While I Transfer Your Call” Prompt, page 6-11

 • Enabling Alternate Greeting Notices (Cisco Unity Voice Messaging with Microsoft Exchange 
2003/2000 Only), page 6-12

 • Enabling a Post-Greeting Recording, page 6-13

 • FAQ Available in the Cisco Unity Administrator and on the Cisco Unity Server Desktop, page 6-15

 • Including Receipts in Message Locator Searches (Cisco Unity with Exchange), page 6-15

 • Live Record, page 6-16

 • Live Reply (“Call the Subscriber”) Behavior When Used to Leave Messages, page 6-16

 • Setting Up Mobile Message Access for BlackBerry (Cisco Unity with Exchange), page 6-17

 • Specifying That Cisco Unity Play New Messages Automatically, page 6-18

 • Subscriber Address Book Settings (Cisco Unity with IBM Lotus Domino), page 6-19

 • Subscribers Can Press ## or 00 to Switch Search Modes, page 6-19

 • Errors, page 6-20
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Allowing Subscribers to Access Cisco Unity by Phone Without 
Entering a Password

By default, subscribers are prompted for their password before they can log on to Cisco Unity to check 
messages or change their personal settings. As a convenience to subscribers who often access 
Cisco Unity from a mobile phone, home phone, or phone in a secured office within your organization, 
you may consider specifying that Cisco Unity should not prompt them to enter their password when they 
access their mailbox from their primary extension or alternate devices. (When they call Cisco Unity from 
an unknown extension, Cisco Unity will prompt them for their password as usual.)

Note For security reasons, it may not be appropriate to allow subscribers who work in shared workspaces, 
cubicles, or other public areas in your organization (such as a lobby or reception area) to access 
Cisco Unity by phone without first entering a password.

Do the following procedure to allow an individual subscriber to access messages by phone without 
entering their password when they call from their primary extension or an alternate device. (To allow a 
group of subscribers to access Cisco Unity by phone without entering their password, use the Bulk Edit 
tool available in Tools Depot.) Note that neither the Cisco Unity Assistant nor the Cisco Unity 
conversation offer a way for subscribers to make the change themselves.

Subscribers who do not have to enter their password to log on to Cisco Unity are still prompted to renew 
their password when it expires.

To Allow Subscribers to Access Cisco Unity by Phone Without Entering a Password

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Subscribers page and find the applicable 
subscriber. Then browse to the Phone Password page.

Step 2 In the Prompt for Phone Password section, check the Only When User Calls From Unknown 
Extension check box. 

Step 3 Click the Save icon.

Changing How Cisco Unity Handles Messages That Contain 
Text (Cisco Unity with Exchange)

If your organization has both Voice Messaging and Unified Messaging subscribers, messaging between 
the two types of subscribers can be problematic. This is because Voice Messaging subscribers cannot use 
the Cisco Unity conversation or the Cisco Unity Inbox to access text in e-mail messages. In addition, 
when a message contains both a voice recording and a text message—as may be the case when a Unified 
Messaging subscriber uses Cisco Unity ViewMail for Microsoft Outlook to send, reply, and forward 
messages to Voice Messaging subscribers, the Cisco Unity conversation and the Cisco Unity Inbox 
present only the voice portion of the message. Moreover, Cisco Unity informs neither the sender nor the 
recipient that all or a portion of a message is unavailable to the recipient.
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You can set up Cisco Unity so that it rejects messages sent to Voice Messaging subscribers if the 
messages contain text. In this way, you can ensure that Voice Messaging subscribers receive only those 
messages that they can play in their entirety. At the same time, when Cisco Unity rejects messages that 
contain text, Unified Messaging subscribers receive a nondelivery receipt (NDR) and can learn to adjust 
their messaging habits accordingly. 

For more information see the following sections:

 • Using the Message Store Manager to Change How Cisco Unity Handles Messages That Contain 
Text, page 6-3

 • Understanding How Messages That Contain Text Are Handled After You Set Up Cisco Unity to 
Reject Them, page 6-4

 • Task List for Setting Up Cisco Unity to Reject Messages Sent to Voice Messaging Subscribers If the 
Messages Contain Text, page 6-7

Using the Message Store Manager to Change How Cisco Unity Handles 
Messages That Contain Text

The Message Store Manager utility allows you to set up agents that perform the task that you assign them 
to do. You specify which subscriber mailboxes are members of an agent; only the mailboxes that you 
specify are impacted by the task performed by the agent. To set up Cisco Unity so that it rejects messages 
sent to Voice Messaging subscribers if the messages contain text, you need to create two agents: 

 • One agent applies a rule that rejects messages that contain text. The agent applies the rule to the 
subscriber mailboxes that you specify as agent members. You use a Cisco Unity distribution list, 
class of service, an extension range, or an imported CSV file to specify agent members. To specify 
Voice Messaging subscribers as agent members, we recommend that you use a distribution list or 
class of service. In this way, as you add members to a distribution list or a class of service, 
membership in the agent is automatically updated at the same time and the rule is applied to the 
mailboxes associated with the updated list or class of service.

 • A second agent removes the rule that was applied by the first agent. Once the first agent applies the 
rule to reject messages that contain text, the rule continues to do so until the second agent removes 
it. Thus, even after you remove a subscriber from the distribution list or class of service that you 
specified as a member of the first agent, the rule continues to reject messages from the subscriber 
mailbox if the messages contain text. As a convenience, we recommend that you set up a second 
agent to remove the rule from all subscriber mailboxes on the server, except those associated with 
Voice Messaging subscribers. By doing so, you will not have to create a new agent to remove the 
rule from a single mailbox whenever a Voice Messaging subscriber is removed from the distribution 
list or class of service that you specified for the first agent.

You schedule how often you want each agent to run. For example, you may choose to run the agents 
nightly, weekly, or at some other interval, depending on how often you add or remove subscribers from 
the class of service or distribution list that you use to specify agent membership. As you determine how 
often to run the agents and when, also consider that if Voice Messaging subscribers do not appear in the 
Outlook address books, agents will take longer to run. Note that as an agent runs, the previously hidden 
mailboxes appear in address books, and then, when the agent completes its task, the mailboxes are 
hidden once again. For this reason, you may want to schedule the agents to run when subscribers are not 
likely to use the system. (Voice Messaging subscribers are often prevented from appearing in the Outlook 
address book as way to discourage people from inadvertently sending e-mail messages to a Voice 
Messaging account.)
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When you set up the agents, you can activate the Subscriber Message Store Status report, or you can 
schedule the report to run at a certain time. The report is a CSV file that contains detailed data about 
each subscriber mailbox that is a member of the agent. When the value of the VM Mailbox Rule column 
equals one (1), the rule associated with the first agent has been applied; when the value equals zero (0), 
the rule has not been applied to the mailbox. 

For more information working with Message Store Manager to set up agents and run reports, refer to 
Help.

Understanding How Messages That Contain Text Are Handled After You Set Up 
Cisco Unity to Reject Them

When you set up Cisco Unity so that it rejects messages sent to Voice Messaging subscribers if the 
messages contain text, Voice Messaging subscribers continue to receive receipts, faxes, and voice 
messages as before, but many other types of messages are no longer delivered. Knowing how 
Cisco Unity handles messages differently can help you prepare both Voice Messaging and Unified 
Messaging subscribers for the change.

Table 6-1 compares how Cisco Unity handles messages by default to how messages are handled after 
you set up Cisco Unity to reject messages sent to Voice Messaging subscribers if the messages contain 
text. Consider that when Cisco Unity rejects a message, it does so when the Voice Messaging subscriber 
is the sole recipient of the message and when the subscribers is one of many recipients, as may be the 
case when a message containing text is sent to a distribution list. Note that in a few cases, Cisco Unity 
does not reject certain types of messages that you may expect, while it rejects others that you may not 
expect.

Table 6-1 Understanding How Messages That Contain Text Are Handled After You Set Up Cisco Unity to Reject 

Them 

Type of Message Sent to Voice 
Messaging Subscriber

Application Used 
to Send Message

How Cisco Unity Handles 
Message by Default

How Cisco Unity Handles 
Messages When Set Up to Reject 
Messages That Contain Text

Voice message with text in subject 
line

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers can access subject line 
only in Cisco Unity Inbox.

Does not deliver message; sends 
an NDR to sender.

Voice message with text in subject 
line

Cisco Unity 
Inbox

Delivers message as voice 
message; Voice Messaging 
subscribers can access subject line 
only in Cisco Unity Inbox.

Same as default.

Voice message with text in 
message body

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.

Voice message with a non-WAV 
attachment

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access the 
attachment.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message with voice 
recording and text in message 
body

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.
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Reply to voice message with text 
in message body

ViewMail Delivers message as e-mail 
message that Voice Messaging 
subscribers cannot access.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message with 
non-WAV attachment

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access the 
attachment.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message with no 
voice recording, no change to 
subject line, and no text in 
message body

ViewMail Delivers message as e-mail 
message that Voice Messaging 
subscribers cannot access.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message with 
change to text in message body

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message with 
change to subject line

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers can access subject line 
only in Cisco Unity Inbox.

Does not deliver message; sends 
an NDR to sender.

Reply to voice message with 
change to subject line

Cisco Unity 
Inbox

Delivers message as voice 
message; Voice Messaging 
subscribers can access subject line 
only in Cisco Unity Inbox.

Same as default.

Reply to voice and text message 
with voice recording and deletion 
of all text

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Same as default.

Reply to voice and text message 
with voice recording 

Cisco Unity 
conversation

Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.

Reply to voice and text message 
with voice recording

Cisco Unity 
Inbox or 
ViewMail

Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Same as default.

Reply to e-mail message with 
voice recording and text in 
message body

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.

Reply to e-mail message with 
voice recording

Cisco Unity 
conversation or 
ViewMail

Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Same as default.

Reply to e-mail message with text 
in message body 

ViewMail Delivers message as e-mail 
message that Voice Messaging 
subscribers cannot access.

Does not deliver message; sends 
an NDR to sender.

Table 6-1 Understanding How Messages That Contain Text Are Handled After You Set Up Cisco Unity to Reject Them 

(continued)

Type of Message Sent to Voice 
Messaging Subscriber

Application Used 
to Send Message

How Cisco Unity Handles 
Message by Default

How Cisco Unity Handles 
Messages When Set Up to Reject 
Messages That Contain Text
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Forwarded voice message with 
voice introduction and text in 
message body

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message with 
text in message body

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message with 
non-WAV attachment

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access the 
attachment.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message with 
change to text in message body

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message with 
change to subject line

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers can access subject line 
only in Cisco Unity Inbox.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice message with 
change to subject line

Cisco Unity 
Inbox

Delivers message as voice 
message; Voice Messaging 
subscribers can access subject line 
only in Cisco Unity Inbox.

Same as default.

Forwarded voice and text message 
with or without voice introduction

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Same as default.

Forwarded voice and text message 
with or without voice introduction

Cisco Unity 
conversation or 
the Cisco Unity 
Inbox

Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded voice and text message 
with deletion of all text

ViewMail Delivers message as voice 
message.

Same as default.

Forwarded e-mail with text in 
message body

ViewMail Delivers message as e-mail 
message that Voice Messaging 
subscribers cannot access.

Does not deliver message; sends 
an NDR to sender.

Forwarded e-mail message with 
voice introduction and text in 
message body

ViewMail Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Does not deliver message; sends 
an NDR to sender.

Forwarded e-mail message with 
voice introduction

Cisco Unity 
conversation or 
ViewMail

Delivers message as voice 
message; Voice Messaging 
subscribers cannot access text.

Same as default.

Forwarded e-mail message with 
no change to subject line or 
additional text

Cisco Unity 
conversation or 
ViewMail

Delivers message as e-mail 
message that Voice Messaging 
subscribers cannot access.

Does not deliver message; sends 
an NDR to sender.

Table 6-1 Understanding How Messages That Contain Text Are Handled After You Set Up Cisco Unity to Reject Them 

(continued)

Type of Message Sent to Voice 
Messaging Subscriber

Application Used 
to Send Message

How Cisco Unity Handles 
Message by Default

How Cisco Unity Handles 
Messages When Set Up to Reject 
Messages That Contain Text
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Task List for Setting Up Cisco Unity to Reject Messages Sent to Voice 
Messaging Subscribers If the Messages Contain Text

Complete the following tasks to set up Cisco Unity so that it rejects messages sent to Voice Messaging 
subscribers if the messages contain text:

1. Identify the Voice Messaging subscribers on your Cisco Unity server. For example, create a class of 
service or public distribution list for Voice Messaging subscribers, and then use the Cisco Unity 
Administrator or Bulk Edit to assign the appropriate subscribers to it. (Note that how you identify 
Voice Messaging subscribers from Unified Messaging subscribers is up to you; neither the way in 
which you created them, nor how they are licensed, identifies them as Voice Messaging or Unified 
Messaging subscribers for this feature.)

2. Set up the two agents that will enable Cisco Unity to reject messages sent to Voice Messaging 
subscribers if the messages contain text without changing how messages are handled for other 
subscribers. See the “To Set Up an Agent to Reject Messages That Contain Text When the Messages 
Are Sent to Voice Messaging Subscribers” procedure on page 6-8 and the “To Set Up an Agent to 
Ensure Unified Messaging Subscribers Receive Messages That Contain Text” procedure on 
page 6-9.

3. Customize ViewMail for Outlook version 4.1(1) so that when it is installed on subscriber 
workstations, messages that are sent to Voice Messaging subscribers are checked for text. Then 
install the customized version of ViewMail on all subscriber workstations. See the “To Customize 
ViewMail for Outlook Version 4.1(1) to Check for Text When Subscribers Send Messages to Voice 
Messaging Subscribers” procedure on page 6-9 and the “To Install the Customized Version of 
ViewMail 4.1(1) on All Subscriber Workstations” procedure on page 6-10.

Note If you already installed the standard version of ViewMail 4.1(1), you cannot simply install the 
customized version of ViewMail to enable the feature. You also cannot repair the existing 
installation to enable the feature. To enable the feature if you already installed the standard 
version of ViewMail 4.1(1), you must change the value of a registry key to 1 on all subscriber 
workstations. The registry key is HKEY_LOCAL_MACHINE\SOFTWARE\Cisco 
Systems\Cisco Unity\VMO\NoTextToVM. It is a DWORD key. You can edit the registry on each 
subscriber workstation, or you can use a software publishing tool to update the key value on all 
subscriber workstations at once.

E-mail message with WAV 
attachment

E-mail program Delivers message as e-mail 
message that Voice Messaging 
subscribers cannot access; Voice 
Messaging subscribers cannot 
access the attachment.

Does not deliver message; sends 
an NDR to sender.

E-mail message E-mail program Delivers message as e-mail 
message that Voice Messaging 
subscribers cannot access.

Does not deliver message; sends 
an NDR to sender.

Table 6-1 Understanding How Messages That Contain Text Are Handled After You Set Up Cisco Unity to Reject Them 

(continued)

Type of Message Sent to Voice 
Messaging Subscriber

Application Used 
to Send Message

How Cisco Unity Handles 
Message by Default

How Cisco Unity Handles 
Messages When Set Up to Reject 
Messages That Contain Text
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4. Subscribers who use Microsoft Outlook 2002 and later will get a Microsoft Outlook security alert 
when they use the customized version of ViewMail. Tell subscribers that they can safely click Yes 
in response. The standard text for the security alert informs users that an application is attempting 
to access the Outlook Address Book, and asks them if they want to allow it. (In fact, ViewMail does 
not access the Address Book, but it does check for text in each message that triggers the alert.) To 
learn more about the Microsoft Outlook Security feature—as well as how to customize or disable it, 
refer to the Microsoft Office Assistance topic, “Customizing the Outlook Security Features 
Administrative Package,” in the “Administering Outlook Security” chapter of the Messaging 
Deployment Guide on the Microsoft website.

5. Consider letting subscribers know what to expect now that Cisco Unity rejects messages sent to 
Voice Messaging subscribers if the messages contain text. Give everyone a list of Voice Messaging 
subscribers so that they know which subscribers cannot receive messages that contain text. In 
addition, tell Unified Messaging subscribers that if they receive an NDR in response to a message 
that they sent to a Voice Messaging subscriber, they should remove all text before attempting to 
resend the message. Remind them that NDRs can also be triggered when a recipient has a full 
mailbox.

Note When you move a Voice Messaging subscriber mailbox from one Exchange server to another, the rules 
associated with the mailbox continue to work after the move. The same is true when you move a Voice 
Messaging subscriber from one Cisco Unity server to another. If the other Cisco Unity server is not 
already set up to reject messages that contain text, consider enabling it to do so. In this way, messages 
to Voice Messaging subscribers on that server are handled consistently. Alternatively, you can create a 
new agent to remove the rule from the individual mailbox before moving the subscriber to the other 
Cisco Unity server. 

To Set Up an Agent to Reject Messages That Contain Text When the Messages Are Sent to Voice Messaging 
Subscribers

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Administrative Tools, double-click Message Store Manager.

Step 3 From the File menu, click New Agent. 

Step 4 Enter a name for the agent, then click OK. For example, consider naming the agent, “Reject Text to VM 
Subscribers.”

Step 5 Right-click the Included folder, and click the option that allows you to specify that only Voice 
Messaging subscribers are members of the agent. For example, if you created a class of service to 
identify Voice Messaging subscribers from everyone else on your server, click Add Class of Service. 

Step 6 Click the applicable class of service or distribution list that you created to identify Voice Messaging 
subscribers from everyone else on your server, then click OK. 

Step 7 Click the Scripts directory.

Step 8 From the list displayed in the right pane, right-click Add VM Mailbox Rules and click Activate.

Step 9 In the MSM Script dialog box, click the Schedule tab. Specify how often you want the agent to run.

Note The agent takes longer to run if any members are currently hidden from Outlook address books.

Step 10 Click OK to close the MSM Script dialog box. 
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To Set Up an Agent to Ensure Unified Messaging Subscribers Receive Messages That Contain Text

Step 1 From the File menu, click New Agent. 

Step 2 Enter a name for the agent, then click OK. For example, consider naming the agent, “Remove VM 
Subscribers Rule.”

Step 3 Right-click the Included folder, and click the option that allows you to specify all subscribers as 
members of the agent. For example, if you have an All Subscribers distribution list, click Add 
Distribution List. 

Step 4 Click the applicable class of service or distribution list that contains all subscribers on the server, then 
click OK.

Step 5 Right-click the Excluded folder, and click the option that allows you to specify that Voice Messaging 
subscribers are excluded as members of the agent. For example, if you created a class of service to 
identify Voice Messaging subscribers from everyone else on your server, click Add Class of Service. 

Step 6 Click the applicable class of service or distribution list that you created to identify Voice Messaging 
subscribers from everyone else on your server, then click OK. 

Step 7 Click the Scripts directory.

Step 8 From the list displayed in the right pane, right-click Delete VM Mailbox Rules and click Activate.

Step 9 In the MSM Script dialog box, click the Schedule tab and specify how often you want the agent to run.

Note The agent takes longer to run if any members are currently hidden from Outlook address books.

Step 10 Click OK to close the MSM Script dialog box. 

To Customize ViewMail for Outlook Version 4.1(1) to Check for Text When Subscribers Send Messages to Voice 
Messaging Subscribers

Step 1 Download ViewMail 4.1(1) from the ViewMail for Microsoft Outlook Software Download page. Refer 
to the procedure, “To Download ViewMail 4.1(1)” in the “Downloading ViewMail 4.1(1)” topic in the 
Release Notes for Cisco Unity ViewMail for Microsoft Outlook Release 4.1(1) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/vmo/vmo411rn.htm.

(ViewMail 4.1(1) will be available soon from the ViewMail for Microsoft Outlook Software Download 
page. It is not available with the Cisco Unity software.)

Step 2 Browse to the ViewMail directory on the network drive where you downloaded the ViewMail files. If 
you do not have rights to write to the directory, move the files to a directory that allows you to do so.

Step 3 In the ViewMail directory, browse to the ENU language folder.

Step 4 Open the VMOInit.VBS file in a text editor such as Notepad.

Step 5 Enter Session.Property("NOTEXTTOVM") = "1" immediately before the End Function line, as shown 
below:

Function VMOInitFn()
rem Session.Property("EXTENSION") = ""
rem Session.Property("UNITYSERVER") = ""
Session.Property("NOTEXTTOVM") = "1"
End Function
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Step 6 Save the script file and close the text editor.

Step 7 Open a Command Prompt window. (On the Windows Start menu, click Programs > Accessories > 
Command Prompt.)

Step 8 Change to the ViewMail > ENU directory.

Step 9 Enter vmaddbin ViewMail.MSI VMOInit.VBS, and press Enter. (When the script completes, your 
cursor returns to the command line.)

Step 10 Close the Command Prompt window.

To Install the Customized Version of ViewMail 4.1(1) on All Subscriber Workstations

Step 1 Review the Release Notes for Cisco Unity ViewMail for Microsoft Outlook Release 4.1(1) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/vmo/vmo411rn.htm for requirements, 
installation instructions, and other important information.

Step 2 Using the ViewMail.msi file that you customized in the “To Customize ViewMail for Outlook Version 
4.1(1) to Check for Text When Subscribers Send Messages to Voice Messaging Subscribers” procedure 
on page 6-9, install ViewMail 4.1(1) on all subscriber workstations.

You can install ViewMail by using any of the methods described in the “Installing ViewMail 4.1(1)” 
topic in the Release Notes for Cisco Unity ViewMail for Microsoft Outlook Release 4.1(1) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/vmo/vmo411rn.htm.

Disabling Delete Confirmations in the Cisco Unity Inbox (Cisco 
Unity with Exchange Only)

You can use the Advanced Settings Tool to change the registry so that the Cisco Unity Inbox either never 
asks subscribers to confirm a deletion, or asks them to confirm a deletion only when deleting an item 
will delete it permanently. By default, when subscribers delete messages and other items from the 
Cisco Unity Inbox, they are asked to confirm the deletion. This is true when subscribers delete new and 
saved items, as well as when they delete items in the Deleted Items folder (as applicable). 

For details on setting up this functionality, refer to Advanced Settings Tool Help. The setting is called 
Unity Inbox—Confirm Deletes.

Disabling the “Record Your Message at the Tone” Prompt
By default, Cisco Unity plays the “Record your message at the tone” prompt after playing a subscriber 
or call handler greeting. Because some subscribers instruct callers when to record their messages in their 
greetings, callers hear the instruction twice. For this reason, you may want to specify that Cisco Unity 
does not play the prompt after some or all greetings when callers leave messages for particular 
subscribers or call handlers in your organization.
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Do the following procedure to disable the “Record your message at the tone” prompt for subscriber 
templates, individual subscribers, or call handlers. (To disable the prompt for a group of subscribers, use 
the Bulk Edit tool available in Tools Depot.)

To Disable the “Record Your Message at the Tone” Prompt in a Subscriber Template, for an Individual Subscriber, 
or Call Handler

Step 1 In the Cisco Unity Administrator, go to the applicable page:

 • To modify the template you will use to create subscriber accounts, go to any Subscribers > 
Subscriber Template page, and find the template that you want to modify. Then browse to the 
Greetings page.

 • To modify an existing subscriber account, go to any Subscribers > Subscribers page and find the 
applicable subscriber. Then browse to the Greetings page.

 • To modify an existing call handler, go to any Subscribers > Subscribers page and find the 
applicable subscriber. Then browse to the Greetings page.

Step 2 Check the Do Not Play the “Record Your Message At The Tone” Prompt check box.

Step 3 Click the Save icon.

Disabling the “Wait While I Transfer Your Call” Prompt
By default, Cisco Unity plays the “Wait While I Transfer Your Call” prompt when it transfers a call to 
an extension. Some callers do not like hearing the prompt, and for this reason, you may want to specify 
that Cisco Unity does not play it. 

Do the following procedure to disable the “Wait While I Transfer Your Call” prompt for subscriber 
templates, individual subscribers, or call handlers. (To disable the prompt for a group of subscribers, use 
the Bulk Edit tool available in Tools Depot.) Note that when you disable the prompt, callers still hear the 
transfer tones from Cisco CallManager, as applicable.

To Disable the “Wait While I Transfer Your Call” Prompt in a Subscriber Template, for an Individual Subscriber, 
or Call Handler

Step 1 In the Cisco Unity Administrator, go to the applicable page:

 • To modify the template you will use to create subscriber accounts, go to any Subscribers > 
Subscriber Template page, and find the template that you want to modify. Then browse to the Call 
Transfer page.

 • To modify an existing subscriber account, go to any Subscribers > Subscribers page and find the 
applicable subscriber. Then browse to the Call Transfer page.

 • To modify an existing call handler, go to any Subscribers > Subscribers page and find the 
applicable subscriber. Then browse to the Call Transfer page.

Step 2 In the While Transferring Notify Caller section, check the Do Not Play the “Wait While I Transfer 
Your Call” Prompt check box.

Step 3 Click the Save icon.
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Enabling Alternate Greeting Notices (Cisco Unity Voice 
Messaging with Microsoft Exchange 2003/2000 Only)

Because subscribers never hear the greetings of their message recipients when they send, reply to, and 
forward messages, consider enabling “alternate greeting notices” for the Cisco Unity server so that 
subscribers are alerted when a message recipient has the alternate greeting enabled. Alternate greeting 
notices are a type of message receipt and work as follows: whenever a subscriber leaves or sends a 
message to a subscriber who has the alternate greeting enabled, Cisco Unity delivers the message and 
also sends the sender an alternate greeting notice. The alternate greeting notice says:

“The alternate greeting for <subscriber name or ID> is on and will remain on until <expiration date 
for the greeting>. The message you sent was delivered, but the recipient may not be available to play 
it.” (Alternatively, Cisco Unity will indicate when the greeting is set to play indefinitely, rather than 
playing the expiration date.) 

(Subscribers “send” messages by using the Cisco Unity conversation, ViewMail, or the Cisco Unity 
Inbox; they “leave” messages after transferring to a subscriber greeting and then recording a message as 
prompted.)

An alternate greeting notice is sent in response to the first message that a subscriber leaves or sends to 
a recipient within the time period that the recipient has the alternate greeting enabled. If the subscriber 
leaves or sends subsequent messages to the same recipient, Cisco Unity do not respond with additional 
notices (unless the recipient turns off the alternate greeting and then enables it again). 

When the feature is enable, subscribers can play notices by phone or they can view the text from the 
Cisco Unity Inbox, assuming that they can access receipts (you can disable receipts per server in the 
Advanced Settings Tool). Though alternate greeting notices are automated responses, they are from the 
message recipient. Thus, subscribers can use the Message Locator to find both messages and notices 
from a particular subscriber. Note that like other types of receipts, alternate greeting notices do not 
trigger message waiting indicators (MWIs).

Cisco Unity does not send notices in response to system broadcast messages, nor does it sent notices to 
unidentified callers. Cisco Unity sends a notice to the sender when the message is addressed to an 
individual subscriber or to a distribution list of which the recipient is a member. The same is also true 
regardless of whether the sender and recipient are homed on the same Cisco Unity server or separate 
servers that are digitally networked (assuming the feature is enabled for each server). When other 
networking features (AMIS, Bridge, VPIM) are used, subscribers do not receive notices in response to 
messages left for or sent to remote Cisco Unity or Cisco Unity Express subscribers, nor do they receive 
notices in response to messages left for or sent to remote users on a another voice messaging 
system—even when the recipients have their alternate greeting or similar type of greeting (such as an 
extended absence greeting) enabled. 

Alternate greeting notices are disabled by default. Enabling alternate greeting notices can only be done 
per server; you cannot specify that notices are sent in response to messages sent to individual subscribers 
or to a specific group of subscribers, nor that only certain subscribers can receive them. In digitally 
networked environments, the feature should be enabled for all Cisco Unity servers in the network.

To set up the Cisco Unity server to send a notice to subscribers when they leave, send to, reply to, or 
forward messages to other subscribers who have their alternate greeting enabled, do the procedure in this 
section. After you do the following procedure, when subscribers associated with the Cisco Unity server 
enable their alternate greeting, Cisco Unity will send an alternate greeting notice to any subscriber who 
sends a message to them. (Cisco Unity will not send notices in response to messages sent to subscribers 
who already had their alternate greeting enabled before notices were turned on.) 
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Consider providing subscribers with the information in the “Alternate Greeting Notices (Cisco Unity 
Voice Messaging with Microsoft Exchange 2003/2000 Only)” section on page 8-1 so that they 
understand how to notices work.

If you later choose to disable alternate greeting notices, any existing notices in subscriber mailboxes are 
no longer available to subscribers until you enable the feature again and subscribers will no longer 
receive notices—even if other Cisco Unity servers in the network have the feature enabled. 

Note Alternate greeting notices cannot be enabled for Cisco Unity with Exchange 5.5 systems. In addition, 
due to conflicts with the “Out of Office” rule in Outlook, enabling alternate greeting notices for Unified 
Messaging systems is not supported.

To Enable Alternate Greeting Notices for a Cisco Unity Server 

Step 1 On the Cisco Unity server desktop, double-click the Cisco Unity Tools Depot icon.

Step 2 In the left pane, under Administrative Tools, double-click Advanced Settings Tool.

Step 3 In the Unity Settings pane, click Conversation—Alternate Greeting Notices.

Step 4 In the New Value list, click 1 and click Set. 

Step 5 When prompted, click OK.

Step 6 Click Exit.

Step 7 Restart the Cisco Unity software.

Note If you do not restart the Cisco Unity software whenever you enable or disable the feature, notices 
do not behave as expected. 

Step 8 As applicable, repeat the procedure for each Cisco Unity server at your site.

Note For Cisco Unity failover, registry changes on one Cisco Unity server must be made manually on 
the other Cisco Unity server, because registry changes are not replicated.

Enabling a Post-Greeting Recording
You can use the settings on the applicable Subscribers > Class of Service > Greetings page in the 
Cisco Unity Administrator to specify whether Cisco Unity plays a recording before allowing callers to 
leave a message for subscribers assigned to a class of service (COS). For each COS, you use the Media 
Master control bar on the page to record what you want callers to hear, and you indicate whether all 
callers hear the recording or only unidentified callers. Though callers can press # to skip a subscriber or 
call handler greeting, callers cannot skip a post-greeting recording.

When Cisco Unity is enabled to play it, callers hear the recording immediately after a subscriber 
greeting, regardless of which personal greeting is enabled for the subscriber. The post-greeting recording 
also plays after a call handler greeting when the call handler is configured to take a message and the 
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message recipient for the call handler is a subscriber who is assigned to a COS that has the recording 
enabled. (The COS assigned to the owner of a call handler has no effect on whether the recording is 
played.) 

By default, the post-greeting recording feature is disabled for all COSes. Depending on your 
organization and the type of subscribers assigned to each COS, you may want to consider enabling it for 
some COSes, so that those who call certain groups of subscribers—such as a sales team, technical 
support group, or a Human Resources department—hear the recording. For each COS, you can create a 
different recording tailored to those callers and as applicable, in the appropriate language(s). The 
recording can be up to 90 seconds in length.

For example, you may want to enable a post-greeting recording for a particular COS to convey a 
confidentiality policy or to let callers know when they can expect a response to the You can also use the 
feature to remind callers to include contact information, invoice or policy numbers, and other such 
information when they leave messages. Conversely, due to legal or security concerns, you may want to 
advise callers of what information not to include in messages—information like passwords, financial 
transaction requests, and so on.

Note that a post-greeting recording does not play when:

 • The message recipient for a call handler is assigned to a distribution list.

 • Subscribers send, reply to, or forward messages to other subscribers, and when subscribers call a 
subscriber extension, log on to Cisco Unity during the subscriber greeting, and then leave a message.

Note When you create a new COS based on an existing one, the new COS inherits the post-greeting recording 
settings but not the recording itself.

Do the following procedure to enable a post-greeting recording for a class of service. Whether you plan 
to enable the feature for a new COS or an existing one, consider testing the feature by enabling it for a 
new COS that has a test subscriber account assigned to it. In this way, you can call the test subscriber to 
hear how your recording will sound after the greeting and can adjust what you plan to say accordingly.

Enabling a Post-greeting Recording for a Class of Service

Step 1 In the Cisco Unity Administrator, go to the applicable Subscribers > Class of Service > Greetings page.

Step 2 In the After Greeting, Play Recording Before Taking Messages section, select one of the following 
options to enable the feature and indicate which callers will hear the recording: 

 • Play Recording Only for Unidentified Callers—Before they leave a message, outside callers and 
subscribers who did not log on to Cisco Unity before calling from an external phone or from a phone 
that is not associated with a subscriber account hear the subscriber or call handler greeting and then 
the recording.

 • Play Recording to All Callers—Before they leave a message, subscribers and outside callers hear 
subscriber or call handler greeting and then the recording. 

Step 3 Use the Media Master control bar to record what you want callers to hear, or specify an existing WAV 
file as the recording. 

(You use the Copy/Paste From File options on the Options menu of the Media Master control bar to use 
a prerecorded WAV file as the recording.) 

Step 4 Click the Save icon.
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FAQ Available in the Cisco Unity Administrator and on the 
Cisco Unity Server Desktop

An FAQ is available in the Cisco Unity Administrator and on the desktop of the Cisco Unity server. The 
FAQ addresses questions often asked by Cisco Unity administrators. 

To Display the Cisco Unity Administrator FAQ

Step 1 Click the Cisco Unity Administrator FAQ link at the bottom of the navigation bar. Cisco Unity 
displays the FAQ in a separate window.

Or, from the Cisco Unity desktop, click the Cisco Unity Administrator FAQ shortcut.

Step 2 Click the available links to review questions and answers.

Including Receipts in Message Locator Searches (Cisco Unity 
with Exchange)

You can specify whether to include new and saved receipts in Message Locator searches on the 
applicable Features page for a subscriber template or an individual subscriber in the Cisco Unity 
Administrator or by using the Bulk Edit utility. By default, receipts are not included in Message Locator 
searches. 

When subscribers search for messages from a particular subscriber and Message Locator is set to include 
receipts, the following receipts are included in search results, in addition to voice messages: nondelivery 
receipts (NDRs), return (read and delivery) receipts, and alternate greeting notices. Note that receipts 
are included in the search results regardless of whether subscribers can access receipts when they check 
messages by phone or in the Cisco Unity Inbox. (You can use the Advanced Settings Tool in Tools Depot 
to prevent subscribers from accessing receipts.)

Do the following procedure to include receipts in Message Locator searches in a subscriber template or 
for an individual subscriber. (To do so for a group of subscribers, use the Bulk Edit tool available in Tools 
Depot.) Consider providing the applicable subscribers with the information in the “Message Locator 
Searches Include Receipts (Cisco Unity with Exchange)” section on page 8-3 so that they understand 
what to expect when they use the Message Locator.

To Include Receipts in Message Locator Searches in a Subscriber Template or for an Individual Subscriber

Step 1 In the Cisco Unity Administrator, go to the applicable page:

 • To modify the template you will use to create subscriber accounts, go to any Subscribers > 
Subscriber Template page, and find the template that you want to modify. Then browse to the 
Features page.

 • To modify an existing subscriber account, go to any Subscribers > Subscribers page and find the 
applicable subscriber. Then browse to the Features page.

Step 2 Check the Include Receipts in Searches check box.
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Step 3 Click the Save icon.

Live Record
Live record allows subscribers to record conversations while they talk to callers. The recorded 
conversation is stored as a message in the subscriber mailbox, and the subscriber can review it later or 
redirect it to another subscriber or group of subscribers. Operators in your organization may find live 
record particularly useful.

Live record is supported only when Cisco Unity is integrated with a Cisco CallManager phone system. 
In addition, live record does not work for subscribers who have full mailboxes. When a subscriber who 
has a full mailbox records a call, the feature seems to work normally, but the recorded conversation is 
not stored as a message in the subscriber mailbox.

The Advanced Settings Tool allows you to specify how often Cisco Unity plays a beep as a call is 
recorded and how long the beep plays. To set up live record—including the beep, refer to the Cisco Unity 
Tools website at http://www.ciscounitytools.com/App_LiveRecord_405.htm. 

Consider providing the applicable subscribers with the information in the “Live Record” section on 
page 8-2 so that they understand how to use the feature and can review the following disclaimer. 

DISCLAIMER: The use of monitoring, recording, or listening devices to eavesdrop, monitor, retrieve, 
or record phone conversations or other sound activities, whether or not contemporaneous with 
transmission, may be illegal in certain circumstances under federal, state and/or local laws. Legal advice 
should be sought prior to implementing any practice that monitors or records any phone conversation. 
Some laws require some form of notification to all parties to a phone conversation, such as by using a 
beep tone or other notification method or requiring the consent of all parties to the phone conversation, 
prior to monitoring or recording the phone conversation. Some of these laws incorporate strict penalties. 
In cases where local laws require a periodic beep while a conversation is being recorded, the Cisco/Unity 
phone system provides a user with the option of activating “the beep.” Prior to activating Cisco/Unity's 
call record function, check the laws of all applicable jurisdictions. This is not legal advice and should 
not take the place of obtaining legal advice from a lawyer. IN ADDITION TO THE GENERAL 
DISCLAIMER THAT ACCOMPANIES THIS UNITY PRODUCT, CISCO ADDITIONALLY 
DISCLAIMS ANY AND ALL LIABILITY, BOTH CIVIL AND CRIMINAL, AND ASSUMES NO 
RESPONSIBILITY FOR THE UNAUTHORIZED AND/OR ILLEGAL USE OF THIS UNITY 
PRODUCT. THIS DISCLAIMER OF LIABILITY INCLUDES, BUT IS NOT NECESSARILY 
LIMITED TO, THE UNAUTHORIZED AND/OR ILLEGAL RECORDING AND MONITORING OF 
TELEPHONE CONVERSATIONS IN VIOLATION OF APPLICABLE FEDERAL, STATE AND 
LOCAL LAWS.

Live Reply (“Call the Subscriber”) Behavior When Used to Leave 
Messages

When subscribers use the live reply feature to return a call from a subscriber and then leave a message 
for the subscriber whom they called, Cisco Unity uses the calling number to identify who the message 
is from. This means that Cisco Unity can correctly identify who the message is from only when a 
subscriber uses live reply from his or her own extension. 
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When a subscriber uses another phone to use live reply and leave a message for a subscriber, Cisco Unity 
does not correctly identify who the message is from. Instead, Cisco Unity may indicate that the message 
is from an “unidentified caller” even though the subscriber who left the message was logged on to 
Cisco Unity at the time.

Setting Up Mobile Message Access for BlackBerry (Cisco Unity 
with Exchange)

The Mobile Message Access for BlackBerry is not a licensed feature, nor does it require that you give 
subscribers special class of service (COS) privileges. As long as their Blackberry devices are connected 
to a Blackberry server that has a Mobile Message Access for BlackBerry plug-in installed and the 
devices are configured properly, subscribers can use their Blackberry devices to access Cisco Unity 
voice messages. 

Voice messages appear along with other messages in the BlackBerry Inbox. To play a Cisco Unity voice 
message, subscribers use their BlackBerry device to open the message and click the associated link. 
Cisco Unity calls the phone number specified for message playback, and when the subscriber answers 
the call, the message begins to play. (Note that the restriction tables associated with the subscriber class 
of service may prohibit them from specifying certain phone numbers for message playback.) 

The menu options available during and after message playback are the same as those available when 
subscribers log onto Cisco Unity to play messages over phone. After saving or deleting a message, 
subscribers can select another message from the BlackBerry Inbox to play, or they can press * to log on 
to Cisco Unity to perform other tasks. 

Task List for Setting Up Mobile Message Access for BlackBerry
Do the following tasks to set up Mobile Message Access for BlackBerry for subscribers:

1. Optional: Set up Cisco Unity to use the Secure Sockets Layer (SSL) protocol in its communications 
with the BlackBerry server so that the data exchanged between the Cisco Unity server and the 
BlackBerry server is sent over an encrypted HTTPS connection. In addition, consider preventing the 
BlackBerry device from displaying the resulting security alert. 

To do so, refer to the task list in the “Manually Setting Up the System to Use SSL” section of the 
“Using SSL to Secure Client/Server Connections” chapter in the Cisco Unity Security Guide, 
Release 4.0. The Exchange version of the guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/usg/ex/index.htm. The 
Domino version of the guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/usg/dom/index.htm.

2. To allow subscribers to use the phone as a recording and playback device, specify that Cisco Unity 
has at least one voice messaging port designated for this purpose. 

Refer to the “Voice Messaging Port Settings” section in the “System Settings” of the Cisco Unity 
System Administration Guide, Release 4.0(5) for more information. The Exchange version of the 
guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/ex/index.htm. 
The Domino version of the guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/dom/index.ht
m.
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3. Install the Mobile Message Access for BlackBerry plug-in on the BlackBerry server. Refer to 
Release Notes for Cisco Unity Mobile Message Access for BlackBerry Release 1.0(1) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/bb/bb101rn.htm. The document 
specifies the requirements and procedures for installing the Mobile Message Access for BlackBerry 
plug-in.

4. Provide subscribers with the procedures in the “Using Mobile Message Access for BlackBerry 
(Cisco Unity with Exchange)” section on page 8-3 so that they can set up their devices to use the 
BlackBerry browser. In addition, the first time that they use the BlackBerry device to access 
Cisco Unity voice messages, they will need to specify the phone number that Cisco Unity calls to 
play messages.

Specifying That Cisco Unity Play New Messages Automatically
By default, subscribers hear the Main menu after they log on to Cisco Unity. You can customize the 
conversation so that Cisco Unity plays new messages instead. When you do, subscribers no longer have 
to press a key to play new messages (“Press 1 for new messages”) because Cisco Unity begins playing 
them automatically.

Otherwise, the conversation that subscribers hear sounds and acts the same: 

 • Cisco Unity plays the subscriber recorded name, alternate greeting notification, new message 
counts, and the Message Type menu as specified. 

 • System broadcast messages, full mailbox warnings, reminders to reset passwords, and other such 
prompts are likewise played before Cisco Unity begins playing new messages. 

 • Subscribers must indicate whether they want to save or delete the message before Cisco Unity plays 
the next new message.

 • Subscribers can exit message playback to hear the Main menu at any time. 

 • If subscribers have no new messages, the Main menu is played as usual.

To specify that Cisco Unity plays new messages automatically in a template or for an individual 
subscriber, do the following procedure. (To do so for a group of subscribers, you can use the Bulk Edit 
tool available in Tools Depot.) Note that neither the Cisco Unity Assistant nor the Cisco Unity 
conversation offer a way for subscribers to make the change themselves. 

After you enable the feature, consider providing the information in the “Checking Messages by Phone 
When Cisco Unity Plays New Messages Automatically” section on page 8-2 to applicable subscribers 
so they understand what to expect when they log on to Cisco Unity to check messages by phone.

To Specify That Cisco Unity Play New Messages Automatically in a Subscriber Template or for an Individual 
Subscriber

Step 1 In the Cisco Unity Administrator, go to the applicable page:

 • To modify the template you will use to create subscriber accounts, go to any Subscribers > 
Subscriber Template page, and find the template that you want to modify. Then browse to the 
Conversation page.

 • To modify an existing subscriber account, go to any Subscribers > Subscribers page and find the 
applicable subscriber. Then browse to the Conversation page.

Step 2 Check the New Messages Automatically check box.
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Step 3 Click the Save icon.

Subscriber Address Book Settings (Cisco Unity with IBM Lotus 
Domino)

The DUC for Cisco Help file, which contains instructions for manually installing csAdmin (the DUC 
administration component for Cisco) when adding a secondary subscriber address book, is named 
csUCAdminGuide.nsf and is included in the DUC for Cisco installation media. To access the Help file, 
open the csUCAdminGuide.nsf database in the Domino Administrator.

Before adding a secondary subscriber address book to Cisco Unity, in addition to the steps listed in the 
Cisco Unity System Administration Guide, Release 4.0(5), you may need to add a Server document to 
the secondary address book database (for example, contacts.nsf) in order for the Cisco Unity server to 
correlate the address book with the Domino domain used to import subscribers. The Server document 
must be added to the $Servers view of the secondary address book. The Server document added to the 
secondary address book must be for the same Domino server to which Cisco Unity is partnered as its 
primary mail server. If this step is required but has not been done, Cisco Unity will display the following 
error when you attempt to add the address book as a secondary subscriber address book:

“The subscriber address book <name> could not be added because the address book must reside in the 
same domain as the Unity server account.”

Subscribers Can Press ## or 00 to Switch Search Modes
When subscribers use Cisco Unity to address messages, edit private lists, or find messages by phone, 
they search for a subscriber either by spelling the name or by entering the extension. Subscribers can 
switch search modes by pressing ## or 00. By default, Cisco Unity responds to either key combination. 
You do not need to configure it to do so. 

It is important to note, however, that when subscribers press 00 to switch search modes, they will 
experience a delay before Cisco Unity responds accordingly. To avoid the delay, subscribers can press 
## instead of 00. Alternatively, you can reduce the amount of time that Cisco Unity waits for key presses 
so that subscribers no longer experience the delay. 

Reducing the amount of time that Cisco Unity waits for more key presses can eliminate the delay when 
subscribers press 00 to switch search modes, but the change may adversely affect how subscribers 
interact with the Cisco Unity conversation when they perform other tasks. For this reason, we 
recommend that you reduce the value specified for the How Long Cisco Unity Waits For Additional Key 
Presses After Subscriber Has Pressed A Key field (also known as the Interdigit Timeout setting) only for 
individual subscribers who are likely to use 00, rather than for all subscribers associated with a 
Cisco Unity server. 

The How Long Cisco Unity Waits For Additional Key Presses After Subscriber Has Pressed A Key field 
is on the Conversation pages for individual subscribers in the Cisco Unity Administrator. By default, 
Cisco Unity waits 3000 milliseconds for additional key presses before it acts.
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The following sections apply to the Cisco Unity System Administration Guide (With IBM Lotus Domino), 
Release 4.0(5) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/dom/index.htm 
and to the Cisco Unity System Administration Guide (With Microsoft Exchange), Release 4.0(5) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/sag/sag405/ex/index.htm, 
unless otherwise noted:

 • Languages, page 6-20

 • Managing Security Alerts When Using SSL Connections, page 6-20

 • Maximum Recording Length for System Broadcast Messaging, page 6-20

 • Message Locator, page 6-21

 • Phone Menu Response Settings, page 6-21

Languages
Disregard the “Languages” chapter of the Cisco Unity System Administration Guide, Release 4.0(5). 
Cisco Unity 4.1(1) is available only in U.S. English. You can install Cisco Unity 4.1(1) only on a server 
on which the U.S. English version of Windows 2000 Server or Windows Server 2003 is installed; you 
cannot change the locale of Windows to a setting other than English (United States); and you cannot 
upgrade an existing Cisco Unity system that is using a language other than U.S. English to version 
4.1(1). 

Managing Security Alerts When Using SSL Connections
The “Managing Security Alerts When Using SSL Connections” section in the “Setting Up Cisco Unity 
Applications on Subscriber Workstations” chapter of the Cisco Unity System Administration Guide, 
Release 4.0(5) should have been removed. 

Updated conceptual information and procedures are available in the “Using SSL to Secure Client/Server 
Connections” chapter of the Cisco Unity Security Guide. The Exchange version of the guide is available 
at http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/usg/ex/index.htm. The 
Domino version of the guide is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/usg/dom/index.htm.

Maximum Recording Length for System Broadcast Messaging
The “Sending System Broadcast Messages” section of the “Cisco Unity Conversation” chapter in the 
Cisco Unity System Administration Guide, Release 4.0(5) incorrectly indicates that the Advanced 
Settings tool only allows you to specify up to 360,000 milliseconds for the maximum recording length 
of system broadcast messages. In fact, you can use the tool to specify up to 3,600,000 milliseconds (60 
minutes) for the maximum recording length. 

The Advanced Settings Tool is available in the Tools Depot. The setting is called Conversation—System 
Broadcast Message Maximum Recording Length. Note that the error has been corrected in Advanced 
Settings Tool Help.
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Message Locator
The Cisco Unity System Administration Guide, Release 4.0(5) incorrectly indicates that when Message 
Locator is enabled, Cisco Unity prompts the subscriber to “Press 5 to find messages” from the Main 
menu for all conversation styles. In fact, for Alternate Keypad Mapping X and Alternate Keypad 
Mapping S, Cisco Unity prompts subscribers to press 8 instead.

Note that the error has been corrected in the Cisco Unity Administrator Help.

Phone Menu Response Settings
The Cisco Unity System Administration Guide, Release 4.0(5) incorrectly indicates that the values that 
you specify for the Phone Menu Response fields in the Cisco Unity Administrator only control some of 
the Cisco Unity phone menus heard by outside callers and subscribers. With the release of Cisco Unity 
version 4.1(1), all of the menus are affected by the values you enter in the Phone Menu Response fields. 

Note that the Cisco Unity Administrator Help on the Conversation pages for subscribers and templates, 
and on the System > Configuration page has been updated to reflect the changes made in Cisco Unity 
version 4.1(1). 
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Cisco Unity Troubleshooting Guide

This chapter should be used in conjunction with the Cisco Unity Troubleshooting Guide, Release 4.0(5). 
New features are described in individual sections. Information that has changed in the Cisco Unity 
Troubleshooting Guide, Release 4.0(5)—either because Cisco Unity functionality changed or because 
the information is incorrect—is described in the “Errors” section at the end of the chapter.

This chapter contains the following sections:

 • Web Pages That Contain the Media Master Control Bar Do Not Load Properly When Google 
Desktop Search Is Installed, page 7-1

 • PIMG Units Produce Unexpected Results, page 7-1

 • Errors, page 7-2

Web Pages That Contain the Media Master Control Bar Do Not 
Load Properly When Google Desktop Search Is Installed

When Google Desktop Search is installed on a subscriber workstation that uses Windows XP, the pages 
of the Cisco Personal Communications Assistant (PCA) and the Cisco Unity Administrator do not load 
properly in the browser. The problem is caused by a conflict between the Media Master and the Google 
Desktop Search. (Cisco Unity ViewMail for Microsoft Outlook is unaffected by the conflict.)

To correct or avoid the problem, find and rename GoogleDesktopNetwork2.dll on the subscriber 
workstation (for example, rename the file “OFF-GoogleDesktopNetwork2.dll”). Explain to subscribers 
that after you rename the file, Google Desktop Search results will no longer appear integrated with 
Google search results. Subscribers can continue to use Google Desktop Search on their workstations, but 
only from the Google Desktop Search page.

PIMG Units Produce Unexpected Results
When Cisco Unity is integrated via PIMG units to a circuit-switched phone system and the PIMG units 
are not producing calls or call information as Cisco Unity requires, perform the applicable diagnostic 
tasks for the PIMG units that the manufacturer suggests. Detailed instructions are in the “Diagnostics” 
chapter of the Intel Netstructure PBX-IP Media Gateway User’s Guide, which is available at the Intel 
website.
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The following section applies to the Cisco Unity Troubleshooting Guide (With IBM Lotus Domino), 
Release 4.0(5) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/tsg/tsg405/dom/index.htm and 
to the Cisco Unity Troubleshooting Guide (With Microsoft Exchange), Release 4.0(5) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/tsg/tsg405/ex/index.htm.

Cisco Unity Services and Their Functions
In the “Cisco Unity Services and Their Functions” appendix of the Cisco Unity Troubleshooting Guide, 
the TomCat service should be included in the “Cisco Unity Services” table:

The TomCat service should also be included in the Exchange 2003/2000 and Exchange 5.5 tables, and 
in the Domino table:

Service Function

TomCat The Tomcat service is responsible for generating the web pages for the 
Cisco Personal Communications Assistant (PCA).

Service Logs On As Startup Mode Comments Dependencies

TomCat Local System Automatic None None
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Cisco Unity User Guide

This chapter should be used in conjunction with the Cisco Unity User Guide, Release 4.0(5). New 
features are described in individual sections.

This chapter contains the following sections:

 • Alternate Greeting Notices (Cisco Unity Voice Messaging with Microsoft Exchange 2003/2000 
Only), page 8-1

 • Checking Messages by Phone When Cisco Unity Plays New Messages Automatically, page 8-2

 • Live Record, page 8-2

 • Live Reply (“Call The Subscriber”) Behavior When Used To Leave Messages, page 8-3

 • Message Locator Searches Include Receipts (Cisco Unity with Exchange), page 8-3

 • Using Mobile Message Access for BlackBerry (Cisco Unity with Exchange), page 8-3

Alternate Greeting Notices (Cisco Unity Voice Messaging with 
Microsoft Exchange 2003/2000 Only)

Note When alternate greeting notices are enabled, all subscribers associated with a Cisco Unity server are 
alerted when a message recipient has the alternate greeting enabled. If you enable notices for the 
Cisco Unity server, consider providing the information below to subscribers. 

Alternate greeting notices are a type of message receipt and work as follows: whenever you leave or send 
a message to another subscriber who has the alternate greeting enabled, Cisco Unity delivers the 
message and also sends the sender an alternate greeting notice. The notice says: 

“The alternate greeting for <subscriber name or ID> is on and will remain on until <expiration date 
for the greeting>. The message you sent was delivered, but the recipient may not be available to play 
it.”

You can play notices by phone or view the text from the Cisco Unity Inbox. Alternate greeting notices 
do not trigger message waiting indicators (MWIs).
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Checking Messages by Phone When Cisco Unity Plays New 
Messages Automatically

Note If you set up Cisco Unity to include play new messages automatically, provide the information below to 
applicable subscribers. 

When you call Cisco Unity to check messages, your new messages begin playing automatically. (Note, 
if you have the Message Type menu enabled, Cisco Unity plays the menu instead.) 

Otherwise, the conversation that you hear sounds and acts the same: 

 • Cisco Unity plays your recorded name, alternate greeting notification and new message counts, as 
specified. 

 • System broadcast messages, full mailbox warnings, reminders to reset passwords, and other such 
prompts are likewise played before Cisco Unity begins playing new messages. 

 • You must indicate whether you want to save or delete the message before Cisco Unity plays the next 
new message.

 • You can exit message playback to hear the Main menu at any time. 

 • If you have no new messages, the Main menu is played as usual.

Live Record

Note Provide the information below to applicable subscribers.

Live record allows you to record conversations while you talk to callers. The recorded conversation is 
stored as a message in your mailbox. You can play it or forward it to another subscriber or group of 
subscribers. Note that live record does not work properly when you have a full mailbox.

Before using live record, review the following Disclaimer.

DISCLAIMER: The use of monitoring, recording, or listening devices to eavesdrop, monitor, retrieve, 
or record phone conversations or other sound activities, whether or not contemporaneous with 
transmission, may be illegal in certain circumstances under federal, state and/or local laws. Legal advice 
should be sought prior to implementing any practice that monitors or records any phone conversation. 
Some laws require some form of notification to all parties to a phone conversation, such as by using a 
beep tone or other notification method or requiring the consent of all parties to the phone conversation, 
prior to monitoring or recording the phone conversation. Some of these laws incorporate strict penalties. 
In cases where local laws require a periodic beep while a conversation is being recorded, the Cisco/Unity 
phone system provides a user with the option of activating “the beep.” Prior to activating Cisco/Unity's 
call record function, check the laws of all applicable jurisdictions. This is not legal advice and should 
not take the place of obtaining legal advice from a lawyer. IN ADDITION TO THE GENERAL 
DISCLAIMER THAT ACCOMPANIES THIS UNITY PRODUCT, CISCO ADDITIONALLY 
DISCLAIMS ANY AND ALL LIABILITY, BOTH CIVIL AND CRIMINAL, AND ASSUMES NO 
RESPONSIBILITY FOR THE UNAUTHORIZED AND/OR ILLEGAL USE OF THIS UNITY 
PRODUCT. THIS DISCLAIMER OF LIABILITY INCLUDES, BUT IS NOT NECESSARILY 
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LIMITED TO, THE UNAUTHORIZED AND/OR ILLEGAL RECORDING AND MONITORING OF 
TELEPHONE CONVERSATIONS IN VIOLATION OF APPLICABLE FEDERAL, STATE AND 
LOCAL LAWS.

Live Reply (“Call The Subscriber”) Behavior When Used To 
Leave Messages

Note Provide the information below to applicable subscribers.

When you use the live reply feature to return a call from a subscriber and then leave a message for that 
subscriber, Cisco Unity uses your calling number to identify who the message is from. Cisco Unity can 
correctly identify who the message is from only when you use live reply from your own extension or a 
number that you have specified as an alternate device in the Cisco Unity Assistant. 

When you call from another number, Cisco Unity may indicate that the message is from an “unidentified 
caller” even though you were logged on to Cisco Unity at the time that you left the message.

Message Locator Searches Include Receipts (Cisco Unity with 
Exchange)

Note If you set up Cisco Unity to include receipts in Message Locator searches, provide the information below 
to applicable subscribers.

When you use the Message Locator to search for messages from a particular subscriber, nondelivery 
receipts (NDRs), return (read and delivery) receipts, and alternate greeting notices are included in the 
search results—in addition to voice messages. 

Using Mobile Message Access for BlackBerry (Cisco Unity with 
Exchange)

Note If you set up the Mobile Message Access for BlackBerry feature for your site, provide the information 
and procedures below to applicable subscribers.

You can use your BlackBerry device to check voice messages in your Cisco Unity mailbox. Voice 
messages appear along with other messages in your BlackBerry Inbox.

To set up your BlackBerry device to check voice messages in your Cisco Unity mailbox, you must 
specify that it uses the BlackBerry browser. In addition, the first time that you use the device to access 
Cisco Unity voice messages, you will need to specify which phone number that Cisco Unity calls to play 
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your messages. You can change the number at any time. To set up your device, do the first procedure in 
this section, “To Set Up Your BlackBerry Device to Access Voice Messages in Your Cisco Unity 
Mailbox (First-Time Use Only).” 

Once your device is properly set up, you can use the second or third procedure (as applicable) in this 
section to check voice messages using your BlackBerry device:

 • To Use Your BlackBerry Device to Check Voice Messages in Your Cisco Unity Mailbox (Standard 
Conversation), page 8-4

 • To Use Your BlackBerry Device to Check Voice Messages in Your Cisco Unity Mailbox (Optional 
Conversation 1), page 8-5

Note that you cannot use your device to play the voice messages that you may have received or saved 
before you set up the device.

Keypad mappings for other conversation styles are documented in the “Cisco Unity Phone Menus and 
Shortcuts” chapter of the Cisco Unity User Guide. Ask your Cisco Unity administrator which 
conversation style you are set up to use.

To Set Up Your BlackBerry Device to Access Voice Messages in Your Cisco Unity Mailbox (First-Time Use Only)

Step 1 On your BlackBerry device, confirm that the Default Browser Configuration is set to use the BlackBerry 
Browser. 

Step 2 From the BlackBerry Inbox, click a Cisco Unity voice message, and then click Open. 

Step 3 In the message body, select the link and click Get Link from the menu.

Step 4 In the Cisco Unity Voicemail Password field, enter the numeric password that you use to log on to 
Cisco Unity by phone.

Step 5 In the Number To Call To Play Messages field, enter the phone number of the BlackBerry device or 
another phone, beginning with any access code needed to make an external call (for example, 9). Use 
digits 0 through 9. Do not use spaces, dashes, or parentheses between digits. For long-distance numbers, 
also include 1 and the area code. You can also enter:

 • , (comma) to insert a one-second pause.

 • # and * to correspond to the # and * keys on the phone.

Note You cannot enter phone numbers that include plus signs (+). If you are experiencing difficulties with this 
setting, contact your Cisco Unity Administrator.

Step 6 Click Submit.

Step 7 Test your setup:

a. Click Call #. 

b. Answer the phone when it rings; Cisco Unity should begin playing your message.

c. If the phone number does not work, click Change #, then repeat Step 4 through Step 7

To Use Your BlackBerry Device to Check Voice Messages in Your Cisco Unity Mailbox (Standard Conversation) 

Step 1 From the BlackBerry Inbox, click a Cisco Unity voice message, and then click Open. 
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Step 2 In the message body, select the link and click Get Link from the menu.

Step 3 to activate it.

Step 4 Answer the phone when it rings. 

Step 5 Use the following keys to control playback as you listen to a message.

Step 6 Use the following keys to manage the message after you have listened to it. 

Step 7 After saving or deleting the message, you can:

 • Follow the system prompts to play another message or log on to Cisco Unity to perform other tasks.

 • Hang up, and click the Back button on your device to return to the BlackBerry Inbox.

To Use Your BlackBerry Device to Check Voice Messages in Your Cisco Unity Mailbox (Optional Conversation 1) 

Step 1 From the BlackBerry Inbox, click a Cisco Unity voice message, and then click Open. 

Step 2 In the message body, select the link and click Get Link from the menu.

Step 3 Answer the phone when it rings. 

Key(s) Task Key(s) Task

1 Restart message 8 Pause/Resume

2 Save 9 Fast-forward

3 Delete # Fast-forward to end

4 Slow playback ## Skip message, save as is

5 Change volume1

1. Not available on some systems.

* Cancel or back up

6 Fast playback 0 Help

7 Rewind message

Key(s) Task Key(s) Task

1 Replay message 6 Save as new  
(The message waiting indicator 
on your phone may light or 
remain lit.)

2 Save 7 Rewind message

3 Delete 9 Play message properties

4 Reply # Save as is

42 Reply to all * Cancel or back up

44 Call the subscriber1

1. Not available on some systems.

0 Help

5 Forward message
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Step 4 Use the following keys to control playback as you listen to a message.

 

Step 5 Use the following keys to manage the message after you have listened to it. 

Step 6 After saving or deleting the message, you can:

 • Follow the system prompts to play another message or log on to Cisco Unity to perform other tasks.

 • Hang up, then click the Back button on your device to return to the BlackBerry Inbox.

Key(s) Task Key(s) Task

1 Rewind message 6 Fast playback

2 Pause/Resume 66 Faster playback

3 Fast-forward 7 Decrease volume1

1. Not available on some systems.

33 Fast-forward to end 8 Reset volume1

4 Slow playback 9 Increase volume1

44 Slower playback # Skip message, save as is

5 Play message 
properties

## Skip message, save as new 
(The message waiting 
indicator on your phone 
may light or remain lit.)

6 Fast playback * Cancel or back up

66 Faster playback 0 Help

Key(s) Task Key(s) Task

1 Skip back 88 Call the subscriber1

1. Not available on some systems.

4 Replay message 9 Save

5 Play message properties # Save as is

6 Forward message ## Save as new

7 Delete message * Cancel or back up

8 Reply 0 Help

82 Reply to all
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C H A P T E R 9

Networking in Cisco Unity Guide

This chapter should be used in conjunction with the Networking in Cisco Unity Guide, Release 4.0(5). 
New features are described in individual sections. Information that has changed in the Networking in 
Cisco Unity Guide, Release 4.0(5)—either because Cisco Unity functionality changed or because the 
information is incorrect—is described in the “Errors” section at the end of the chapter.

This chapter contains the following sections:

 • Private List Considerations, page 9-1

 • Errors, page 9-1

Private List Considerations
Consider notifying subscribers in the event that the following members are inadvertently removed from 
their lists:

 • When you delete a delivery location, blind addressees are removed from all private list.

 • When an external subscriber becomes a regular subscriber, the external subscriber is removed from 
all private lists.

Errors
The following sections apply to the Networking in Cisco Unity Guide (With IBM Lotus Domino), Release 
4.0(5) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/net/net405/dom/index.htm 
and to the Networking in Cisco Unity Guide (With Microsoft Exchange), Release 4.0(5) at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/unity40/net/net405/ex/index.htm, 
unless otherwise noted:

 • Extension Addresses (Cisco Unity with IBM Lotus Domino Only), page 9-2

 • Requirements for Setting Up Digital Networking (Cisco Unity with Microsoft Exchange Only), 
page 9-2

 • Upgrading and Uninstalling Networking Options (Cisco Unity with Microsoft Exchange only), page 
9-2
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Configuring the Interop Gateway (Cisco Unity with IBM Lotus Domino Only)
In the Networking in Cisco Unity Guide (With IBM Lotus Domino), the procedures for setting up 
Cisco Unity to use AMIS and VPIM omit an additional step for configuring permissions for the interop 
gateway that is required when Cisco Unity is integrated with IBM Lotus Domino release 7.0. The step 
must be done prior to performing the procedure to configure the interop gateway.

In Domino release 7.0, the default permissions set for the -Default- account on the access control list of 
the mailbox.ntf template do not include permission to replicate or copy documents. This permission is 
required when setting up the interop gateway. It can be granted either by adding the permission for the 
-Default- account, or by adding the UnityServers group that was created during Cisco Unity installation 
to the access control list, and granting permission to replicate or copy documents to the group. Refer to 
the applicable IBM Lotus documentation for information on adding this permission.

Extension Addresses (Cisco Unity with IBM Lotus Domino Only)
The Networking in Cisco Unity Guide (With IBM Lotus Domino) incorrectly states that extension 
addresses of AMIS and VPIM subscribers are automatically updated when the Foreign domain name is 
changed. The “Changing the Interop Gateway Foreign Domain Name” section that is in both the “AMIS 
Networking” and “VPIM Networking” chapters of the Networking in Cisco Unity Guide contains the 
correct procedure for changing the Foreign domain name, which includes information on running a 
Domino agent to update the extension addresses.

Requirements for Setting Up Digital Networking (Cisco Unity with Microsoft 
Exchange Only)

The “Requirements for Setting Up Digital Networking” section in the “Digital Networking” chapter of 
the Networking in Cisco Unity Guide (With Microsoft Exchange) states that Cisco Unity servers that are 
digitally networked together can be any combination of Cisco Unity servers, version 3.1(2) or later. This 
statement is not correct for Cisco Unity version 4.1(1). Only Cisco Unity version 4.0(1) and later servers 
can be digitally networked with Cisco Unity 4.1(1) servers.

For more information, refer to the “Digital Networking Requirements for Cisco Unity with Exchange” 
section of Cisco Unity Networking Options Requirements at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/sysreq/netrq.htm.

Upgrading and Uninstalling Networking Options (Cisco Unity with Microsoft 
Exchange only)

The “Upgrading and Uninstalling Networking Options” chapter of the Networking in Cisco Unity Guide 
(With Microsoft Exchange) omits important information for upgrading to Cisco Unity 4.1(1). The 
updated information appears in the following sections:

 • Upgrading with Digital Networking, page 9-3

 • Upgrading with SMTP Networking, AMIS Networking, or VPIM Networking, page 9-3
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Upgrading with Digital Networking

Note that if you upgrade one or more Cisco Unity servers to version 4.1(1), you should upgrade all other 
digitally networked Cisco Unity servers to version 4.0(1) or later. For more information, refer to the 
“Digital Networking Requirements for Cisco Unity with Exchange” section of Cisco Unity Networking 
Options Requirements at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/sysreq/netrq.htm.

Upgrading with SMTP Networking, AMIS Networking, or VPIM Networking

Note that if you upgrade one or more Cisco Unity servers to version 4.1(1), you should upgrade all 
instances of the Cisco Unity Voice Connector for Microsoft Exchange to 11.0(1) or later. 

We recommend that you use the latest version of the Cisco Unity Voice Connector for Microsoft 
Exchange that is supported for your version of Cisco Unity. If you call Cisco TAC with a problem related 
to networking, the Cisco TAC engineer may require that you upgrade to a newer supported version of 
the Voice Connector, if one is available. 

For more information, refer to the applicable section of Cisco Unity Networking Options Requirements:

 • “Version Requirements for SMTP Networking in Cisco Unity with Exchange”

 • “Version Requirements for AMIS Networking in Cisco Unity with Exchange”

 • “Version Requirements for VPIM Networking in Cisco Unity with Exchange”

The document is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/sysreq/netrq.htm.
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